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This edition includes the DVD of our 2009 
Members' Print Exhibition. Once again l 
was invited to cornrnent on the pictures and 

this proved to be the usual enjoyable task. As 
many of you will be aware, my approach to im.age 
appreciation is to be perceptive and imaginative in 
my interpretation. l believe this open non
prescriptive approach to our art is one way of 
improving our appreciation of photography. The 
problem facing judges and selectors when dealing 
with a high volume of entries is one of not being 
allowed sufficient rime to engage with the picture. 
Judgement and selection is too often the product 
of instant gut reaction and nor the result of careful 
analysis and contemplation. Pictures <1re. after all. 
largely intended to be viewed at leisure and 
returned to later. Ir's hardly surprising therefore 
that images that arc instantly judged in seconds 
often fall short of any lasting appeal when viewed 
in the less frenetic surroundings of the gallery. 
Often 'the exhibition irnagc' m<1kcs a brief instant 
statement - it has to - and the authors know this. 
Unfortunately this approach leaves little room for 
deeper appreciation. Lt's always a pleasure to 
discover an image which nor only fulfils the 
crireri<1 for technical excel Jenee but also contains a 
tempting, perhaps an almost elusive, narrative or 
evocative vision that invites return. Pictures st1ch 
as this provide refreshrncnt at each visit, as when 
listening again to a mt1sical composition in which 
one constantly discovers delight in st1btle nuances 
and myriad associations. Fortunately when 
viewing a series of images for a personal response 
comment, as when preparing for the exhibition 
DVD, time can be allowed to look deeper into the 
picture and comprehend how its content speaks to 
the individual (in this case me). The author of the 
picture is 50% of the exchange: the other 50% is 
the viewer. If we are to gain from the experience 
we must be prepared to enter this visual dialogue; 
it's not difficult and it's certainly worthwhile. We 
certainly hope that you enjoy the DVD - a lot of 
hard work has gone into its production, for which 
we thank fellow O1.G committee member Graham 
Whistler and his editing-suite colleague, Gordon 
Rushton. I've had a lot of fun doing it. However, 
we are exploring a different presentation format 
for 20 IO - and we're open to ideas. 

Artides and lmagt's for DIGIT Winter 2009 

Copy Date end :"lovember 
DIG IT relics on lhc conlriburic.,ns of member;-;. So, 
when will you Si.'JHI me an artick: for l)J(ilT"1 

Remcmhcr thal C\eryone is learning and 1ha1 all 
experience is valuable. You don't need lo be ,in 
cxpcrt writer- we'll help yQu ifnci.·cssary. We nccu 

I low To anidc:-. with your favourite digital technique,; 
and of eoursc your brilliant image;;;. We know you ·re 
out there so we look forward to hearing from you. 
Thank you. J~w.. ~~cl<tltl::J t...R.PS Editor 

I' ma i I: editm~iij/i;:i1.1p.~. or;: 
l Aldenholmc, Weybridge, Surrey KTl3 0JF. CK 

Get Ready For Porljolio Two 
The RPS Portfolio Two is a 
wonderful showcase for 
members' work. The 
Digital lmaging Group has 
been invited to contribute 
three pages 
Portfolio. 

within the 
Clearly, Cli"e l/a1111es FRPS 

delighted as we are, the · Cltaimrn11 

few pages available can't possibly illustrate the 
wide spectrum of our members' work. We can 
rectify this by making sure that as many DlG 
members as possible send pictures for 
consideration to the RPS. lfyour work is accepted 
you receive a copy of the book plus kudos as one 
of the published photogrnpl,ers. Tl,e closing date 
for submissions is 31 October 2009 so time is of 
the essence. Make a start before other events and 
attractions overtake you! Full details and an entry 
form <1re in the September Journal and on line at: 

www .rps.org/resou rces/member _ downloads/ 
RPS__portfolio_two_AS _flyer _2009.pdf 

A Great D"Y in October 
We have a major event this aun1mn - a great day 
with Steve Caplin on 25 October at The Old 
School House, Oldbury, West Midlands. Steve 
will present Reality and lllusion - a serious look at 
the conflicting issues of digital manipulation. 
Steve wi II present plenty of examples and 
methods ~howing how to manipulate images and 
produce alternate realities. Steve is one of the 
UK's leading digital-imaging illustrators and 
Photoshop special-techniques wizard. His best
selling books include How to Cheat in Pl\Otoshop 
and Art and Design in Photoshop. Discover full 
details about this must-see event on the back 
cover, together with a major portrait workshop 
weekend next year. Book your places now'. 

Cl.ivt HtrtJ~ FR.'P.S 

WE'VE GOT YOt:R (RPS) l'iF\1BER. 
Bt:T HAVE WE GOT YOt:R E.\'IAIL? 

We want to kct~p you infom1ed but to do that we 
m:ed your email. Do you recognise your RPS 
membership number in the list below? Ir so, and 
you want to receive o..:ca~ional circulars from the 
l)f Group, pkasc contact Bob Pearson f-RPS on 
the special email: secretary.dig~htinternet.com 
to updali.: your contact details. And please put this 
address in your email system to ensure th~ 
incoming mail is recognised . 

/065 13960 37062 
9250 29354 40450 
94/2 
10302 
/0456 
/5543 
/8507 
I 93l0 
20133 
l3/4l 
13/42 
l3790 

](Jt,]l) 

29629 
l97/t, 
30105 
3/517 
Jl895 
J3i05 
338 /0 
361 Ji 
362()/ 

40577 

53545 
53997 
53<)1)i 
54625 
555fi8 

5(,061 
57065 
5i 133 
57674 

58444 
58488 
5949/ 
51)i91) 
fi()()8l) 

60358 
61182 
(>/(,')] 

61742 
6396/ 
{ii563 
61)()1).J 

69459 
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Action Points from recent discussions from Secretary Bob Pearson FRPS 
• Group Publicity Brochure to be updated with 
2009 exhibition images and new text and produced 
by mid-September. 
• Exhibition Judges and Speaker were being 
arranged for 20 I 0. DV l) produced at higher qua] ity 
for lower cost than last year. Slide show without 
commentary to be also made for use as silent loop 
ar events and Fenton House. Agreed to continue 
producrion in 20 I 0. Chairman had successfully 
presented exhibition DVD for four years so new 
presenter was to be found. 
• Plans for a Weekend Portrait WorksJtop at 
Cheltenham Filrn Studios, limited to 36 dclegares 
each with own laptop, were approved. Travel 
Lodge nearby for overnight stays. 
• Panorama Group would not be forming or 
joining a Special interest Group. 
• Finance. VAT was now chargeable on ticket 
events. The provision for Think Photography was 
no longer needed as the event would not take place 
this year. Steve Caplin day was now an RPS event 
and would not appear in DlG accounts. lR 100 
events were now also RPS funded. 0th.er activities 
were generally running below budget. 
• Website and Forum Unclear what form 
proposed Society remplate would tal-:e bur would be 
progressed as soon as available. Flow diagram of 
website components to be published in DIGIT. 
Noted that main RPS foorum is totally open and the 
few members (about 20 were active out of 200 
registered) who used the DJ Group foorum seemed 
to prefer to keep that part private. Chairman to 
confirm committe's view on foorum. 
• Events The Real Thing, Steve Caplin, now 
underwritten by Society who were taking bookings 
by phone with credit card payment only. Separate 
cheques for lunches were collected by DIGIT editor 
- a complicated an-angemenr. RPS International 

Prinr 1-'.xhibition to be opened by President at 
event. So far only few bookings. There were 
opportunities to encourage members to attend with 
publicity at regional events like the Midlands 
Digital event and a second email to members. 
• Riverhoose Barn Exhibilion, Surrey, 6i24 
October 2010 showing early prints from Collection 
alongside modern digital prints was also Society 
underwritten event and would become RPS 
traveling exhibition. lf dig.ital files from Hradford 
archive not available, exhibition would be the best 
digital work of today. List of photographers to be 
asked to donate a print for selection to be drawn up. 
• DIGIT !\ext issue. out by end September, 
would again be 48 pages and include Exhibition 
lJVD. Promotional articles lil-:e last issue's 
fixerlabs thought valuable bur restrict to one or 
rwo a year. 
• R.egional Group Affairs Agreed to establish 
DJGRO sub committee to co-ordinate regional 
affairs and move towards uniform financi,11 
approach and visibility to outside world. The 
DIGRO guidelines leaflet needed updating and re
issuing. Regional events to be entered on website 
and reports of events to be sent to DIGIT. Co
ordination of RPS regional events and DT events ro 
be encouraged. Communication between DlGROs 
to be by telephone and email. Plan to establish 
DlGROs in vacant or inactive regions. Thought to 
be given to expanding Thames Valley Region to 
cover London. 
• e-Campaign mailshot sent successfully to 720 
approved emails out of membership of 970. 
Second mailshot to re-publicise Steve Caplin Day. 
• Colour Group Print Circle would become 
DIG Print Circle. 
• Portfolio Two DI Group to be represented in 
this publication, ideally with separate IR section. 

DATES FOR YOUR DIARIES 

NATIONAL EVENTS 
25 October 2009: Reality and .Illusion Steve Caplin - see back cover. 8001< by I October 

18 April 2010: AGM 
24/25 April 2010: Port rails, Fashion and Nudes - see page 47 and back cover. 

REGIONAL EVENTS 

THAMES V ALL£Y 
IOOO Sunday 27 September 

Ray Spence f-RPS Alternative Digital Techniques 
1000 Sunday 25 October 

Famous for Five il-1inutes ... or ten or fifteen! 
1000 Sonday 22 .l\ovember 

AGM and Millennium Cup Competition 
Details: www.rpsdig-tJrnmesvalley.org.uk 

WESSEX 
1000 Sunday 18 October 

Mel Gigg f-RPS Far Red to Deep Blue 
Infra Red & Underwater Photography and 

Antonia Cox Underwater Photography 
Details: www.digwessex.rps.org/ 

YORKSHIRE 
1000 Sonday 27 Seplember 2009 

Print Apprecilltion and 
Print Presentation: Double Exposure 

Paul.a and Guy Davies FRPS 
Details: w·"w.ydig.co.uk 

DIG/Tis printed by Tan Allan Printing. Riverdene Business Park, Moisey Road, Hersham, Surrey KTl2 4RG 
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Digital Imaging GrouF 

DIGITAL 
REGIONAL 

ORGANISERS 
Contact the organisers listed 

below for full details 

Thames Valley 
Roger No,1011 LRPS 

Vl'l'l'W.rpsdig-thamesvallry.01·1,}uk 
digro@rp:;dig-thame:-vali<:y.org.uk 

East Anglia 
Vacant 

East Midlands 
Bob Rowe ARPS 

www .rpsdigital-em.org.o k 
bob. rowe I O(i~n I I world. com 

.Midlands 
Clive Haynes 1-'RPS 

,vww.midig.org 
dive(_a;crhj<Jto. CO. uk 

North West 
Harry Bosworth 

ha nJ4Jos@aol.com 

Scotland 
Vacant 

Southern 
Dr Barry Senior HonFRPS 

hany@I i 11/epicsfreesrve. co.11k 

South Wales 
Maureen Albright ARPS 

wnw.southwales-dig.r1>s.org 
111aw-een(ij),nw1ireenalbrigh1.l·om 

We.'i.<,ex 
Maureen Albright ARPS 
,,,ww.digwessex.rps.org 

mauree11@ma11ree11al/Jr(ghi.co111 

\Vestern 
Tony Poole ARPS 

101111§J0olg({1)b/i1wmule1·.m.1tk 

Yorkshire 
Robert Croft LRPS 
www.ydig.co.uk 

rohert(cj;;nhe,tcrqfi. w,madoo.co.uk 
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WEB SITE ROUTE MAP JIM BUCKLEY LRPS 

OH WHAT A TANGLED WEB 
WE WEA VE ••• Sir Walter Scott, Marmion 

Well I know that's what some of you think but since the sad loss of the excellent 
interactive web site designed and operated by Bill Henley and his son Iain the committee 
has struggled to offer members alternative ways of posting and commenting on images as 
well as keeping you up-to-date with news and events. The circular emails from Secretary 
Bob Pearson FRPS are just one of the latest innovations and seem to be proving highly 
successful. But use of the website itself remains slow to develop. Here I want to encourage 
you to find your way around and enable you to contribute. Our indefatigable web guru 
Maureen Albright ARPS is seeking where possible to integrate several 
facilities into the main Society website. Apart from the obvious consistency, 
this has the huge advantages of no cost to the Group and enhanced security. 
We are nearly there and this route map aims to guide and attract you to use 
the facilities which have been made available for members. 

Society Home Page: www.rps.org 
DI Group .Forum: www.rpsforum.org 

;:,~-===:-.. ..._ ____ , ___ __ 
- -·----

··-·--
----- .......... _ ......... ·-·---··<---:~ ::;--:,. ~~;.~ 

-- "11 

B[C01ttl: A MEMBER 

JOINTHERPSTODAY .'f . 

•• 
.I • -- ·--~ .. ~----·- · -• .-, H,,, ,I 

i 'f1i'* PhPtt11111•!u, 
'i,Y:-4,' s,,.,. I\ 

l!E,i~1.:.11ma;1r,g.c.iroup 

--

__ .., 
·--~::---·---

--r.--

..._ ____ _ 
-.---..1,------0.,,,--......... __.._,._ 

- . --· 
EPSO~ 

SAVEOVER · ......;_.... 
f>18• 

NOW ~ 
t42084 '----- ..... 
~ ._....ll:", ... 
~ ..._111(()0 

BECOME A r'iet8£R 
JOIN THE RPSTOMY .'f . 

Start with the Society home page at www.rps.org as shown on the left. Here 
you will find all Society news and events. a hosr of material such as the new 
Distincrions Handbook, the oppommity to display your portfolio and a 
discussion forum. You need to register for this Forum ro enable you to use rl1e 
Dl Group 1-'orum. Any problems in registering. contact Tony l\.fant at rhe 
Society on Tony(j},rps.org. 1-'rom rhe Society home page. selecr 1)1 Group 
from the drop down menu at rhe bottom, as circled in the box on rhe left. You 
will now have access ro all the information about your Group: events, DIGIT, 
exhibition and your ponfolios. Pur this in your bookmarks or fovourircs. 
Once registered for the main RPS Forum you will have accl'ss to the privarc 
DI Group membl'rs' Forum. To enjoy and participate click on Forum link ar 
ror right hand corner of rhe main black header of tbl' Society site or from the 
DI Group section header. It's marked with a red square in these examples . 
Your login details will show at rhe rop righr. Put rhis in your favourites or 
bookmarks so you can go there directly. You can now scroll down ro the DJ 
Group interncrive site where you can post images for discussion, seek 
answers to your questions, l'ntl'r thl' online cornpetition, sell and buy and 
offer tips and hints. Go on: Give it a go, it's your wcbsir.c'. 

-·-
- " ·~---.,-... 

·---.. --.. 
- ••1..--

- -,,._..=_~==-=---
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MEMBERS'P EXHIBmON 2009 ALEX DUFTY LRPS 

PICTURES AT AN EXHIBITION 
With over 100 entries this year - and gratifyingly several from outside the UK so thank 
you to those members who take the time and trouble to submit - our tireless Exhibition 
Organiser Alex Dufty was well pleased with the three showings at Taunton, West 
Swindon Libary and Smethick Photo Soc. Here is his report. And look out for the DVD 
inside this issue of DIGIT. We arc immcnsl.cy grateful to Graham Whi.stlcr FRPS and his 
colleague Gordon Rushton for making the flm and for Clive Haynes' revealing 
commentary. 

T
his year saw a new venue for the Ex.h.ibition at 
Taunron Library. Although Glenys Taylor 
AR PS and John Long AR PS did put an 

Exhibition up there many years ago it has taken me 
three years of applying to get an Exhibition again. 
Taunton is normally booked all year. 
An excell.ent exhibition space, good lighting and 
well laict out screens and glass cases are enhanced 
hy a window onto the road. People walking past 
catch sight of some of the prints and arc attracted 
10 visit the exhibition. ,\ long, siuc window gives 
onro the foyer of the library, so there is hags of 
natural light and plenty of room to walk arounu. 
The front entrance to the Exhibition shown below 
can be seen from a ve1y nice cafe part of the libraiy 
complex. 

On the right you can sec the prints in glass cases as 
well as on the panels. 
The Libra1y staff tell me that the visitor numbers 
arc over 9,000 a week, so if only I 0% saw the 
prints - and l. personally think it would be more 
since visitors co the libra1y were wandering arounu 
as we were putting up, asking what the exhibition 
was all about - then we had a good showing. 
As you can see from these photos it looked good. 
We had all the prints on show and we intend to be 
back there in 20 l l ifwe can book it for two weeks. 
Our other r:wo showings were at the established 
locations in Swindon and Churchbridgc 
(Smetttwick Photo Soc) and proved once again to 
be excellent facilities. I would like 10 thank Judith 
anu Roger Parry for their continuing help in 
hosting our exhibition, year after year, even 
arranging their own helpers to hang the prints, for 
a smooth changeover when we can't make it. 

RPS DIGIT Magazine Autumn 2009 

Ri,:ltt: (J}enys Taylor 
ARPS (111d Alex Duffy 
LRPS all smiles ,ww 
tltat the Exhibition is 
all rem~r to ope11 

Far Ri~ht: lu11 Boulto11 
I.RPS pt1ls tltefinishing 
touches to a panel 

Below: Swi111Jor, 

Next Year .. .') 
We are in discussions 
with the Yorkshire D I 
Group to 
exhibition in June 
20 I 0, and the prints 
will be in Swindon, 
Link Centre Library 
again in July 20 I 0. 
i\nd we hope to be at 
Smethwick as usual in 
the autumn of 2010. 

So, start thinking ahout 
your cnlly now'. 
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MEMBERS' PAGE 

SOMETHING YOU WANT TO SAY? 
This is the place for your ideas and thoughts in print so please let's hear from you. 

A :OOURLE TAKE ON Janet Haines LRPS on a charitab.le idea ... 

PHOTOGRAPHY: 
An Exhibition of Photography 

from two viewpoints. 
With over fifty years of experience between 
them, DI Group rnembers photographers Alan 
Abercrombie FRPS and Phil Drake FRPS are 
holcting a joint exhibition of their work. On 
show at the Ciarden Gallery, Osterlcy Park, 
lslcworth, Middlesex. the exhibition cornprises 
black and white prints illustrating the differing 
styles of the two photographers. 
Alan Abercrornbie's images concentrate on the 
faces of people ctisplaying a whole range of 
emotions whether celebrating, protesting or just 
contemplating. 
Phil Drake's work illustrates patterns, geometric 
shapes anct graphic images concentrating on 
ordinary subjects that can be found in the 
streets. 
The Garden Ciallery, which is free to visit, is an 
intimate venue siniated next to the National 
Tfllst property Osterley House. The opening 
times are 1.300 to 1630 Wednesday 2 I October 
to Sunctay 25 October and Wednesday 28 
October to Saturday 31 October. For details of 
the location and how to get there log on to: 
www.nationaltrust.org.uk/main/w-osterleypark 
For further infonnation contact Alan Abercrombie 
at alanabercromhie@htinternei.co. 11k 

,1l<m Abercmmhie 

(tJI/[ 

H~ve ~<>U s0t riles 
<>f <>! d m0ur,teJ 

prir,ts h~r,~ir,~ 

ur,d ir, ~<>ur h0use? 
•J 

Great way to make space for your new work 
whilst supporting Cancer Research UK 

By giving your old mounted prints to your local 
Cancer Research UK 

shop you will raise vita/ funds to help beat cancer. 

If you have unwanted mounted prints hanging 
around your house and you can participate 

in this fundraising activity: 
· Dig them out 

· & Drop them off! 

Find your local Cancer Research UK shop at 
www.cancerresearchuk.org 
via the 'support us' section. 

From Elaine Herbert ARPS 

t>rnrJL""'-

c;·(eet(.,,g.s. f(Oll'A tl-1e vi.ctoriet"" C.l-1etptei-- of -me R.PS - t:!""d 

co"'-0i--t:!h<Latlo""s o"" tl,ie late.s.t iss1A.e of i:,1c;tT wl1Lcl1 ayyi,.,;eol l-1ei--e et few 

dt:!lj.S. A130. It LS paduol wltl-1 s.o 1M.1,<,cl1 L"'-teres.ti.~ ""'-ateYi.AL ci""d Lt·s. grecit 

to see s1A.cl-1 pi--ofess[o.,,al ']>'(ese.,,tAtt-o"" L"'- A c;rOIA.'J> pubLLcAtt-O"'-. 

C.o~r-C1t1A.latLO"'-S to ALL co.,,cei--"'-td. 

WIie"" we 11'..cet b·(t-tflt1 wl-ie"" r WA»;,.,, tl-1e 1.-lJ<. lt was ALL Yatl-tu Y1A.sned, b~,t 

t dLd e""jotl ~etL~ so """a""!j RPS ']>eopLe wl-tose VI-Cl~s · but v..ot fAces 

- were fA""'-LLt-A r: I e.xpect tlouve 11Acl A 1Mtv1er rouv..ol of v,,,,eetL"'-05 blj ""ow. 

tt was all ""'-OSt stL""'-1A.LAtlv.-g Av..d lt wo~sLcl be v..lce t-f Aus.traLLa weye ""ot 

so far awA t1 A .,,cl we couLd attev..ol ""'-eetlv.-gs ";,,oi--e o~ev... 1-toweve~ to 

i--ecelve ']>~<blicatt-ov..s. Lllee i:,rc;tT 1-teL-ps 1A.S to ~ee-p [.,, to~scl-1 av..d brea~ 

olowv.. tl-1e bAr(Lei--s of clls.tAv..ce. 

TI1Av..~ fo·( all !jDIA. a Ye oloL~ 

J<.Lv..d re~Ards 

eLa(,,,,e 
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DISTINCTIONS GUIDANCE JIM BUCKLEY LRPS 

I WANT A DISTINCTION! 
Well, don't we all but it can seem a bit intimidating. So how do you ·go about it? 
Fortunately the Society has recently updated the excellent Distinctions Handbook and it's 
now available to download as a pdf from the website at: 

www.rps.org/associateship/New-Distinctions-Handbook 
And now there's even more on the website with interactive tutorials and a facility to send 
your images for guidance by senior members who chair the distinctions panels. 

W
hen l wa::; chatting to a young man 
recently about having a crack at a 
distinction he said something rather 

perceptive: I really don't know how good my 
photography is because I've never rneasured it 
against an external standard. With The Society's 
prestigious Distinctions and Qualifications you 
have a measure of achievement which is 
recognised throughout the world. Working 
towards a Distinction in itself improves your 
photographic sk.ills. In his a11icle starting on page 30 
David Cooke stresses how helpful it is to attend 
workshops and seek guidance. Some regions arc 
also experimenting with in formal meetings to 
discuss the distinctions ladder and these are 
proving very successful. 
Perhaps work commitments or travel or health 
restrictions mean you can't get to a workshop. 
You wil.l inevitably seek the help of other 
members who, in my experience, will go to 
enonnous length to help you. Listen carefully to 
what they say, and in some cases what they don't 
say! 
But what if none of that is possible? Indeed, rny 
young friend spends his working life in Russia so 
chat doesn't make it easy. So what's the next best 
thing? Fortunately, there is a good deal of advice 
and a solid base of distilled experience available 

Fixed ;abs software available at 
discount to DIGIT members 

In the spring issue of DlGIT (No 41) we ran DI 
Group member Tim Atherton's article on his 
FocusFixer plugin for Phoroshop sec 
www.fixerlabs.com. Since then some members 
have posted favourable comments on the Forum 
about their successful use of this software, with 
helpful cornrnents by Tim - see Discussion and 
Introductions thread on the Fornm. 
The latest FixerBundle V2 (2.0.5) suite of 
f>hotoshop plug-ins for Mac and Windows 
conrinues to be offered to DIGIT members ma very 
healthy 40% discount. This discount applies to all 
FixerLabs products, including the Combo offer on 
FixerBundle V2 and SizeFixer XL. Use coupon 
Rl'SDIGIT. Jf you already have FixerBundle V2 
you can buy SizeFixer XL with the coupon 
RPSDIGJTXL for the same price as FixerBundle 
V2 and SizeFixer XL together with the Combo 
ofter, in total 40% off the Combo price. 
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Remember: 
www.rpsforum.org 
takes you straight 
to the RPS and DI 

Group Forum 

www.digit.rps.org 
for the DI Group 
area of the main 
Society website 

electronically from the Society. The starting 
point for all aspiring applicants is to read the 
Distinctions Handbook. I cannot stress how 
important this is. Download it frorn the:: web site 
address (see above) and study iT card"ully. 
If you arc airning for the L distinction look at: 
www.rps.org/liceotialeship where you will be 
able to download an interactive presentation from 
which you will learn a good deal. 
As you scarr to assemble your photographs for the 
application, log in with your user name and 
password co: www.rps.org/members to discover 
tbe new facility co upload images for privart. 
guidance from a Panel Chairlllan. I decided to 
give it a go as a guinea pig with a prospective 
panel for my Associateship when the service was 
launched a few weeks ago . 
l logged into the members' area and downloaded: 
How to apply/or Advice and How IO insw/1 FTP 
Programme. Armed with these I prepared a kw 
more i rnages than the 1. 5 J needed for tile 
submission. sized then.1 appropriately following 
the clear steps set out by Andy Moore LRPS, the 
Distinctions Manager of the Socie1y. Within a 
few days I was being guided by a Panel Chairrnan 
about my potential application. l1 was a helpful, if 
sobering, chat and hns given me loTs co think 
about. Give it a go! 

Ot. GD.',IN A....COO. 
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PAULA DAVIES FRPS 

Loch Achrtiochtan I 

BEYOND THE FELLOWSHIP: 
PAULA DAVIES FRPS 

Paula Davies discusses the photography she has been doing since she was awarded her 
Fellowship. 

T
he question I was most 
frequently asked afte: being 
awarded a Fellowship was 

"What arc you going to do now? 
What's your new challenge? The 
answer usually was "I don't know!" 
Something which did happen, once 
the initial euphoria had passed, was 
that I felt nothing that I did was good 
enough. I waoted every photograph I 
took to be one which I considered to 
be good enough to win a medal in an 
international exhibition. J\ow I know 
this is an impossible task and, 
fortunately, after two years I have 
overcome this crisis of confidence 
and am again enjoying my 
photography. 

Did I really need a new challenge? f 
was busy enough as it was and had 
never originally intended to apply for 
a Fellowship. It just followed on from 
being awarded an Associateship when 
a few people, whose judgement I 
respected, suggested that the panel 
was good enough to be expanded. 
So what have f been doing with my 
photography in the past two years? 
I tend not to do much photography 
except when I. am on holiday or 
attending photographic workshops. 
So to keep my enthusiasm going and 
give me an incentive to do something 
with the photographs rather than leave 
them on the computer I enter 
international exhibitions. l also take 
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Loch Achtriochtan Reflection.,; 

an active part on a couple of internet 
forums such as the Digit Forum. 
One of my aims has been to become a 
better landscape photographer and f <lo 
think that T am improving in that field 
(please forgive the pun). We spent a 
memorable morning at Loch 
Achtriochtan at the head of Glencoe. 
This was the only time in a week of 
dull weather when there was some 
sunshine and no wind. .Plenty of 
opportunit.ies were there for the broad 
landscape, tak_en with a wide angle 
lens, such as "Loch Achrtiochtan J". I 
was happy with several of the images 
which I got that morning. However J 
was still drawn to the more intimate 
detail such as the fantastic reflections 
and soon the long lens was on my 
camera resulting in "Loch 
Achtriochtan Reflections". To me a 
much more satisfying image. 
A visit to Tuscany for a week of 
landscape photography was very 
enjoyable, especially the food and 
wine! But T thought the best part was 
visiting the small towns in the middle 
of the day where I could concentrate on 
finding details. In '''.'vlontisi Shutters" 
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lvfontisi Shu((ers 
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PAULA DAVIES FRPS 

Hanging Space 

Bryce Canyo11 

10 

I was drawn to the colours and textures in the old walb 
and also the lines of the shutters contrasting with the 
curve of the wrought iron hand rail. "Hanging Space·· 
was spotted as a photo opportunity by a few of us on 
the workshop and I decided that the image suited being 
toned with light sepia. 
For quite some time now I have enjoyed photographing 
sandstone either with a rnacro lens for small details or 
with a longer lens which can make a small area ofrocks 
on the beach appear to be a large wilderness landscape. 
The opportunity came with a visit to Utah to 
photograph both the wide and the more intimate 
landscape. "Bryce Canyon" was photographed early in 
the day when the low sun brought out the golden 
colours and made the hoodoos appear to glow from the 
inside. Standing on the rim of the arnphitheatre of 
Bryce Canyon at 7 o'clock on a November morning 
was a challenge. It is between 8 and 9 thousand feet, 
the wind was blowing and the temperature was - I S0C. 
In contrast "Antelope Canyon" was photographed in 
the middle of the day. This is the best time for slot 
canyon photography as the sun coming from overhead 
shines down, emphasising the shapes of the rock with 
both direct and reflected light. 
Additionally, f do enjoy trying to produce creative 
work. Being a member of an internet based "creative'' 
study group requires me to produce something new 
once a month and this has become a challenge. 
Visiting Venice at carnival time produced many good 
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PAULA DAVIES FPRS 

Venetian Fa11tasy 

images of the "masks" but lots of people have been there and it is a struggle to produce 
something new. "Venetian Fantasy'' and "The Plotters" are just two montages which I 
have made. "Venetian Fantasy" is a combination of l\vo separate images which have 
been ·'painted" with Corel Painter IX software before bringing them together for the 
final rouches in Photoshop CS3. "The Plotters" was al.so two separate photographs 

1he Plotte/'s 

combined in Photoshop CS3. The 
background has been stretched, 
blurreu anu coloureu to make it 
slightly surrec:11 before bringing in 
the two masked characters. 
I have a website which I am trying 
to keep up-to-date. Together with 
my husbc:ind Guy Davies ARPS I 
give talks to other photographic 
clubs and groups. Occasionally I 
c:irn asked to give a talk ro our local 
U3A, the Women's Jnstirnte and the 
Mothers' Union. J have also founu 
thc:it once people discover that I am 
a keen photographer I get asked ro 
do all sorts of things. One 
interesting, and time consuming, 
project was to montage about I 00 
head and shoulder photographs, 
taken by c:1 non-photographer 
friend, into one group photograph 
as a present for somebody who was 
making a career move to a different 
area. 
So here I am, two years later, still 
being a butterfly - flitting from 
subject to subject - but still 
enjoying my photography. 
lf you would like to look at my, 
reasonably up-to-uate, website you 
will find it at www.pix.elfoto.co.uk. 
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JOHN WIGMORE FPRS 

PHOTOSHOP ACTIONS 
PARTl 

Actions are a very useful feature in Photoshop which can save you a lot of time. In 
this first of a two part feature, John Wigmore explains what they are, how to create 
them and how to use them. 

Actions are a series of recorded instructions and key 
strokes which you have used 10 carry out a function 
or achieve an effect and which you may wish to 

repeat. I use some very simple actions as well as some very 
long and complicated ones and l assign function keys (F2 10 

F 11) for my favourites. They can also be coloured and 
grouped for ease of location. 
CS3 stores actions under c:\ Program files\Adobe\Adobe 

Photoshop CS3\required and/or under \presets with the 
suffix ".atn''. Any you write can be saved wherever you can 
easily find them. I suggest that you use the default location 
when you click on "Save action" as Photoshop will then find 
them for you. 
Once written you should test your action more rhan once on 
different images (files) and make a backup preferably on an 
external device. Your actions are also stored within the 
"preferences" file and will be loaded each time you open 
Photoshop. Simply open the actions palelte and they will be 
there. You may wish to backup your "preferences" file too. 
The actions palette. 
When you first open it (Windows> Actions) you will see 
either a white palette with all actions listed and a row of 
icons ar the bottom for recording etc. or some coloured 
action buttons ready for your immediate use. The coloured 
buuons are presets by Adobe and are best left unmodified! 
ff you do see the coloured buttons then you need to click on 
the tiny arrow at the top right of the palette and rhen click on 
"button mode'' to untick it. (See Fig I). The white palette 
will now appear. 
The easiest way to understand actions is to write a simple 
one, so let's do a bas relief, using one of Photoshop's filters 
"Emboss". This action will cover many of the basic 
essentials for successful action writing. 
Writing the action. 
I. Open your image. Open your actions palelle. 
2. Create a new ser of actions by clicking on that tiny arrow 
in the top right corner, then: 
3. Click on "New set" and name it ''My own actions" or 
similar_, rhen click on OK. 
4. Click on ''Create new action" icon (2nd button from right 
ar the bottom of actions paletle) and give your action a 
name, in this case "Basboss" or whatever will jog your 
memory as to the function of the acrion. Assign a col.our 
&/or a hot (function key) from F2 to Fl l with or without 
Control &/or Shift. 
Start recording. 
5. Click ''RECORD" and the record icon at the palette base 
will glow red. 
6. Hold down "CTRL" and touch "J". This will create a 
duplicate of the background layer called "Layer I''. (You 
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value. 

Untick to deactivate inst(uction. 

Approx position 

/ 

of tiny arrow 
to menu. 

• L~--1 ~ 1.,-1 f v Ba.tbou----- --

.,/ l.-\•er Vii COP\' 

Set name. 

Action 1'arne . 

I> Ernbou 

~ Se-l cv,nnl laye-f 

(> M~e .-drvs.lme-n\ l•ye, 

Stftct Ac1wl P\:ieh 1nenv dem 

~ 5109 

~ e ., _, !LI 21 Trash 

I / rd. \~~ C(eate new action. Reco ,ng 
Stop (recording). . 

Play action. Create new set of actions. 

Fig1mi I: The actions palette 

may need to show the layers palette (Window>l.ayers) to 
see this.) 
7. In rhe menu at the top of the screen_. find filter >stylize> 
emboss and click on "emboss". A dialogue box will appear 
on the screen. Set the angle ro 135°. Height 2 pixels and 
amount to 250%. And then click OK . Desarurate (Ctr! + 
Shift+ "V'). This removes traces of colour if present. 
8. Go to layers palette and change the blend mode from 
"normal" to "overlay". Now this is where Photoshop has a 
quirk. The word "overlay" remains highlighted and all else 
is locked out. Simply left click on your mouse on a blank 
area around your image and the highlighting disappears. 
Why? ... ask Adobe. 
9. Add a levels adjustment layer so the image can be 
tweaked to suit your requirements (Layer> new adjustment 
layer> levels). The levels dialogue box will appear. Click 
OK. Do not change anything in the levels histogram 
window, simply click OK again. 
I 0. The recording part is now complete, so stop recording 
(left button at bottom of actions paleue). However, we still 
have a liule more to do:-
a. Go to the tiny arrow at the top right of the actions palette 
and use "Insert stop". Type yourself a message like "Done" 
b. Adjust levels as necessary. (It is important ro adjust the 
levels now before you flatten the layers. Once flattened, the 
levels adjustment layer is lost. This applies both when 
writing the action as well as when you run ii on another 
image). Finally, flatten the layers if you wish to, and save 
the image as a .psd or .tif file. 
c. Open the actions palette again and you will see your 
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JOHN WIGlVIORE FPiiR.cs;-----------------------

completed action. The emboss instruction will dcfoulr to 
the values used in (7) above and may not suit your needs. 
You can force the action ro ask you for new values bv 
clicking on the little blank grey box to the right of the tick 
in the emboss row A small icon will arpear which confirms 
that when you run the action you will be asked for the 
angle etc Your action should look as in Fig I and your 
layers palette as in Fig 2. 
Now test it. 
Open the original image. Now, go to your action name, 
click on it rhen press the "piny'' icon nt the bottom of the 
actions paletre (3rd from left). and the action will play 
faultlessly. 
To sec the effect of rhc Bas Relief, view your inwge at 
JOO% (Ctrl l-Alr ..- zero). This too can be incorporated into 
your action by clicking on (he tiny nrrow top right of 
actions palette and clicking on "Insert menu item" (just 
above "lnserr stop''). A box saying Menu [rem: N·one 
Selected will appear. Go to the menu bar for View > Actual 
pixels then click OK and it wi II appear in your acrion after 
rhe stop message. Drag and drop it above your stop 
message or it will never be reached by the action since 
"Stop" means just that. Resave the action set to ensure 
these final modifications arc not lost. Click on the name of 
your action set, then click on the tiny a1Tow (top right) and 
click on "sctve actions''. snve and allow to overwrite. 
A 3D effect wi_ll be seen in the image and is useful in 
bringing out (say) rhe texture of a rusty padlock. r suggest 
you now display the actions as buttons (litrlc arrow top 
right, button mode), 
This may all look complicated. bur once mastered. wri(ing 
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actions will save you lots of time and will ensure rhat a 
cornplicnted effect you hc1ve invented can be repeated 
foulrlessly time and time again and fast. The action, Demo 
action.atn, mc1y be downloaded from the Digit Magzine 
section of the DIG Forum at: http://www.rpsforum.org. 
Useful tips. 
I .To see the cffecr of the action, before flattening the layers 
hold down the "Air" key and click on the "Indicates layer 
visibility" icon (eye) for rhe background. This will hide all 
layers except the background so the unmodified original 
image can be seen for comparison. Repeat Alt & click on 
"eye" ro reveal all layers again. 
2. Remember to flatten (if required) and save your 
embossed (Bas relief like) image after you have adjusted 
the levels. 
3.The Fl 2 key can be used to restore to original so acrion 
can be renin. 

I Normal ! v ) Opacity: j 100% [ > ] 

Lock: 0 .:Y + ti Fill: i 100% IT] 

~ ~ ~r 1 :tl lb di levels l 
A 

~ D Layer 1 

~ • BM:lcground t) 

hg11re 2: The layers pnlelle 
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Photo by Eileen Wi~more 

Part of Restoration Required with Unsht1rp 11uis/t. only 

Part ofRestorntio11 Required witlt Basboss action @ +/35° 

Pan of Restoration Required ovith Basboss aclio11@-45° 
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JOHN WIGMORE FPRS 

Pin Mill Origi11al Sh(lrpe11ed 

''DIGI-LITH'' PART 1 
In this first part of a two part series, John ·wigmore explains how to create images 
resembling those from a traditional Lith bind-up process using digital techniques. 

Many years ago, when film was king, .I 
had the pleasure of both seeing, as a 
judge, and creating myself, many 

images produced hy hinding up Lith film with a 
colour transparency, emulsion side to emulsion 
side, and exposing the lith film to white light 
through the transparency in a darkroom. Lith 
film, being only blue sensitive, recorded whites 
and blue skies as hlack and the other colours as 
clear(ish) emulsion depending on the exposure 
given. This became the "inlerneg". 
A variant of this was to use a film such as FP4 
which is sensitive to all colours and therefore 
produced a negative with a Juli range of tones 
depending on whether any filters were introduced 
during the copying. The length of exposure given 
naturally altered the final effect. 
After processing, the "interneg" was bound up, 
emulsion to emulsion side again, with the original 
transparency and copied on to colour transparency 
material. Depending upon the density and tonal 
range of the interneg, a variety of effects could be 
produced most usually with black or near black 

blue s.kies and somewhat luminous reds, yellows 
and greens. Given the right suhject, the results 
were ofien stunning. 
Other more advanced techniques were later 
developed using multiple lith exposures, copied 
on 10 more lith and hound together with the earlier 
liths in different exposure comhinations and 
copied again' Using pin registration, by exposing 
these "multi-internegs" onto colour transparency 
material separateJy through coloured gels of 
filters, a unique style of colour image could be 
produced. l know of one Fellowship which was 
obtained in this way by a Kent based 
photographer, and others perhaps. The process 
was very rime consuming and ro generate all the 
multi-internegs could take a week of evenings, all 
to produce one final derivation. This is only a very 
simplified description of this advanced process 
and may not be complete. 
I decided that it might he worth doing a simple lith 
hind-up to start with, digitally. Several options 
were available to me but to emulate the blue 
sensitivity of lith film, either the hlue channel 
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Pin ;'tfi/1 Sharpened with Digi/i/1, applied 

could be used (channel mixer) or a deep pure blue 
(R=0. G=0. B=255) could be multiplied with an RGB 
colour file, either being inverted to produce a lith
like interneg. This could then be combined 
(multiplied) with the original RGB colour file. levels 
(or "exposure") applied and the final image would be 
similar 10 a lith bind-up. l finally opted for the 
channel mixer as the channel values could be varied 
for greater control. 
I have written an action based upon this method, 
using adjustment layers for improved final n111ing. 
This action may be downloaded from the Digit 
Magazine section of the DlG forum at 
http://www.rpsforum.org. (Editor'.~ note: John 
explains how ;u creale your own ar:tions in his 
Phoiushup A cl ions article which hegins on pag<? I} 
of this edi1ion uf DIGIT) 
Method for Photoshop CS2 or Higher. 
I. Load (open) a sharpened file and duplicate the 
background layer (Ctrl-'T') and rename the layer 
"lnierneg". 
2. Image> Adjustments > Channel Mixer. Tick the 
monochrome box and set al I channels to zero except 
the blue channel which should be 85-100%. 
3. Image> ,'\djustments > Invert. 
4. Change blend mode to multiply. 
5. Add an adjustment layer "exposure" and adjust all 
three sliders to give the required effect. 
You can stop here if you wish, but most internegs 
were shifted slightly out of register to give a 3D or 
Bas Relief effect. If you wish to do this then follow 
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step 6 below. 
6. Select the "interneg" named layer. Filter> Other 
> Offset +/- l or 2 (maximum) for both settings (they 
need not be the same, plus or minus). Cse "wrap 
around". 
If grass appears too bright and intense in colour, use 
hue/saturation to desaturate &/or darken the yellows. 
Hue/saturation can also be used to tweak the 
colouration, if required. 
Finally. save your processed file (flattening it 
beforehand if you wish to). 
I've found that Channel mixer seems to work better 
than "Black & White'' as it gives more control over 
blue/black skies. However, lrnage > Adjustments > 
Black & White may be used instead of channel 
mixer. setting blue to about l 00 and all the others to 
zero. With channel mixer a value of around 85% will 
allow some blue sky and grey clouds ro show whilst 
I 00% or more will give a black sky devoid of any 
tones. 
The above is a basis for much experimentation which 
may lead you on to a technique which is different and 
possibly special for example. used in combination 
with selective colour adjustments! Even white 
clouds can be generated within the lith efiect .. By no 
means all images will respond favourably to this 
treatment, so experiment and have fun 1 

In pai1 2. in a later issue of Digit, 1 shall describe the 
"Lith with white clouds", method and make the 
action available for download. 
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MARTIN ADDISON FRPS 

CREATING PAINTERLY 
PICTURES IN COREL PAINTER 

Although less well known than Photoshop, Corel Painter is a superb 
program for creating painterly pictures from photographs. Designed 
with painters in mind, you create by painting with brushes rather than 
applying filters. Here photographer and author of three books on 
Painter, Martin Addison, takes us through a step-by-step tutorial to 
create a beautiful flower painting from two photographs. Martin has 

worked in many types of photographic media over 35 years, including slides, audio-visual, 
colour prints and now digital images. He lectures and runs courses and demonstrations 
on Photoshop and Corel Painter. See box on next page for special offer on his new book. 

A
t first the program can be rather 
intimidating, with a huge choice of 
brushes and paper surfaces hut, with the 

basics mastered, you can create a variety of 
pictures in any traditional style such as oib or 
watercolour. The picture above of magnolia 
blossoms was created in Corel Painter 11 using 
the cloning process. Cloning in Painter means 
taking the image1y from the original photograph 
and painting it into a new document; the result 
will depend upon what brush type is chosen. 
Being a photographer rather than a painter I use 
photographs as the source for all my pictures. 
Magnolias are such beautiful flowers: the pure 
colors and delicate tones never cease to attract me 
every year. The flowers were fully opened by the Be/011J: Magnolia A a11d B 

time I photographed them and some were starting 
to go over so I decided to combine two 
photographs to make a more satisfactory 
composition. 
When you are combining more than one 
photograph in Painter it is impo11ant to plan where 
each element will he placed in the final 
composition. This avoids running into problems 
of placement once the painting has been 
commenced. What you need to remember is that 
when Painter is cloning from another document it 
I ines up the top half to offset the picture. The files 
used here have already been prepared !or cJoning. 
You can download the original files from my 
website at www.painterforphotographers.co.uk 
to work through the tutorial. 
First, open the two files shown here from the 
website: Magnolia A and B. 
Create a new document: File> New. 
Enter Width 3266 pixels and Height 2 I 36 pixels 
and Resolution 300 pixels per inch. 
Select the Pastels > Square X-Soft Pastel h111sh. 
This is a lovely brush to use for flowers. Keturn 
the brush to the default settings. 
In the Colors palette click the Clone Color option. 
Brush size 137 and Opacity 7%. 
Now to connect this new image file with one of 
the original photographs use File> Clone Source 
and seJect Magnolia A. Turn the Tracing Paper on 
and clone the whole picture ve1y lightly with this 
soft textured brush, avoiding the hard edge on the 
!ell as shown below. 
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Change the clone source to the Magnolia B 
original. rile> Clone Source> Magnolia B. Paint 
the remainder of the picture from this source, 
avoiding the hard edge once again. 
Reduce the Resat slider to zero and blend the 
whole picture. This will provide a delicate colour 
wash for the background. When the Resat slider is 
at zero the brnsh picks up no color from the 
photograph and therefore changes to a blender. 
This is a useful tip to remember as it works with 
most brushes in Painter. 

Make the bnish size 30, Opacity 46% and Resat 
60% and clone the flower petals, following the 
lines of the picture paying particular attention to 
the changes in color or tone Enlarge the picture 
on screen to follow the detail more closely. 
Swop the clone source again to paint the other 
flower. 
Change the brush to size 30, Opacity 20% and 
Resat zero. Gently blend parts of the picture to 
integrate the more detailed areas with the soft 
background. 
Change to bnish size 21.5, Opacity 11 % and Resat 
48%. Bring back some more definite detail, the 
edges of the petals in particular. 
Continue to bring back detail with a smal I brnsh, 
and then soften it with a larger bush at low 
Opacity and Resat values, until you have finished 
the picture. 
Combining several photographs in Painter is great 
fun and can produce some beautiful rextures. This 
picture was planned at the starr, but in many cases 
additional photographs can be added as you go 
along to increase the quality of rhe texrure. 
Have fun'. 

Martin\ 11e111 hook, Painter I 1 for Photographers, 
i.v p11blished by Focal Press i11 the UJ, a11d has bee11 
written specifkally Jo,- tlw.~e wlto 111isli to cre11t,• 
pai11tedy inw,:,·s from their photoxraplrs. l!si11g .~ttrJ,
by-.~tep t11toritlls, pri111able pdf files llnd videu 
tutorials W explui11 lww W get tlte most 11111 ,~f' tire 
Pllinter program, the new edition ltas bee11 
s11hst1111ti11//y revi:,etl 11ml c1111t11i11s 11p111·"ximute~r 
70% 11ew material. It's £26.99 from Amu~on and 
otlter bookshops hut contact ilf11rtin "' 
:'\lartinandDon.~n(ii.;aol.com/or a special discm111tf11r 
DIGIT member~. 

This rutorial used pastel brnshes. However any 
traditional art form can be recreated in the Painter 
program. Alongside are some ex.amples of 
different styles. 
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DAVE URWIN 

HIGH DYNAMIC RANGE 
COMPOSITES 

In this article, David Urwin provides an illustrated discussion of his twin passions of 
High Dynamic Range Imaging (HORI) as applied to the photography of period 
interiors, and the use of these HDR images as the basis for the creation of digital 
composites. You can see more of Dave's work at: www.daveurwinphoto.com. 

TltP. Trmi1 Apprond//itg 

Although I enjoy most genres of 
photography, I'm most at peace when 
photographing period and ecclesiastical 

interiors or, back at home, huddled in front of my 
computer processing the images and using them as 
the starring point for digital composites. Typically 
the types of interior sbot that I like to take are high 
contrast scenes which could not easily be captured 
in a single exposure and, for this reason, I make 
extensive use of HOR based technology to help 
me capture an extended dynamic range. 
Additionally I almost always perform some 
degree of post-processing in Photoshop to 
personalise the images and add back a little of the 
atmosphere and character which is so ~asily 
diluted during HOR processing. 
This article represents an introduction to HOR 
based imaging and an illustrated overview of my 
par1icular application of this technology, which is 

an approach that I think will be of more general 
interest than an intricate button pressing guide to 
my work flow. 
HDR Overview A general problem in both digital 
and tradi1ional film-based photography is the 
capture of'scenes containing very bright hi.ghlights 
and deep shadows. If a long exposure is set to 
preserve and capture shadow detail then highlights 
are typically blown out. Conversely, if' highlight 
detail is preserved with short exposure times, then 
shadow detail will typically be lost. 
Traditional methods for handling such problem 
scenes involve the use of graduated neutral 
density filters which selectively reduce the 
amount of light striking the film or digital sensor 
from brighter areas such as the sky; or exposure 
blending techniques where two or more separate 
exposures are manually blended to preserve both 
highligh1 and shadow detail. 
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The advent of digital camera technology, cheap 
but powerful home computing and advances in 
image processing software has opened up a 
relatively new solution known as High Dynamic 
Range Imaging whereby the full dynamic range of 
a scene may be represented by automatically 
merging a series of separate exposures in a way 
which would be virtually impossible to perform 
manually using traditional exposure blending 
techniques. 
The resultant 32-bit HDR image file must be post
processed in order for it to be visualised with 
conventional monitors and print output devices, 
involving a technique known as tone mapping 
whereby the full tonal range defined within the 
HDR image is compressed sufficient.ly to display 
or print correctly whilst st.ill preserving highlight 
and shadow detail. 
In essence then, HDR processing requires that the 
photographer take a number of separate exposures 
of the scene to be rendered such that collectively 
the exposures span the full dynamic range of the 
scene. This typically requires 3, S. 7 or more 
exposures either taken manually or using the 
camera auto-bracket function. The individual 
exposures are then merged to a single 32-bit HDR 
format file. tone mapped to create a viewable 
representation of the scene, and then typically 
saved in 16-bit TI FF format for post-processing in 
Photoshop or equivalent. 
Merge to HDR and tone mapping can be 
performed in Adobe CS2 and above, or (as I 
prefer) via more specialist software such as 
Photomatix Pro from HDRsoft. Further discussion 
of HDR processing and tone mapping will be 
based on Photomatix Pro, although the general 
techniques and processing principles are generic 
and are equally valid for all HDR imaging 
software. 

Photogi-aphic Technique My standard kit when 
photographing interiors is a tripod mounted Canon 
EOS 50D DSLR fitted with Sigma EX F4.5-5.6 
J 0-20rnm lens, and almost invariably shot at 
I 0mm. l'm a lazy photographer and firmly believe 
in letting the camera do as much of the hard work 
as possible, so metering is set to evaluative and I 
tend to rattle the separate exposures off 
automatically via the auto-bracket function set at 
-2, 0, and +2EY. although I do sometimes pop into 
manual mode and shoot a -4EV exposure where I 

RPS DIGIT Magazine J\ut1111u1 2009 

Aurobrackered exposures 
at -2, 0 and +2EV 

want to retain extra window 
detail. ISO is invariably set at 
I 00 to minimise noise in the 
shadow areas of longer 
exposures, and the camera is 
operated in AV priority mode 
with a typical aperture setting of f/11, although to 
some extent this will depend upon the required 
depth of field in the scene being photographed. 
Mounting the camera on a tripod and triggering 
the shutt.er via a cable release (or the camera self
timer) is strongly recommended to ensure that 
there is no possibility of camera movement 
between exposures. For a high quality HDR image 
it is essent.ial that there is complete alignment of 
the individual exposures taken to capture the 
scene. 
Setting the camera to aperture priority (AV) mode 
is also highly recommended in order that the 
separate expos\lres vary only in sh\ltter speed and 
not aperture width. It is absolutely essential that 
there is no change of aperture, and hence depth of 
field (DOF), between the separate exposures 
representing the scene as this is guaranteed to 
result in a general softness and lack of sharpness 
in the final HDR image. The rule therefore is to 
select a fixed aperture to suit the required OOF 
and to va1y the separate exposures only by altering 
shutter speed. 
Creatio1t ,~(the HDR Image in Photom(lfi.x Pro 
The three bracketed exposures shown here 
illustrate that the 0EV camera calculated exposure 
has foiled to cope with the extremes of light and 
shade in the room. Highlights to the left of the 
frame are significantly over-exposed whilst there 
is a general loss of detail in the shadow areas. As 
can be seen, the -2EV and +2£V exposures 
together extend the captured dynamic range and 
reveal adequate amounts of highlight and shadow 

detail respectively. 
These separate exposures which collectively span 
an extended dynamic range are then merged to 
create a single 32-bit HDR file, this being 
achieved via the Generate HDR menu option. 
Supported input file formats are 8 and 16-bit 
JPEG, 8 and 16-bit TIFF, and R.A W where all 
major RAW file formats are supported. l always 
shoot RAW and my personal preference is to 
process the RAW files in Canon Digital Photo 
Professiona I, saving the processed files in 16-bit 
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Figure 2: A11 example 
tone mapped image 

TIFF fonnat which are then used as input to 
Photomatix Pro. 
When processing RAW input, generation of the 
HOR file is more or less automatic with very little 
requirement for user intervention. Camera 
movement between exposures and moving objects 
within the photographed scene can severely 
degrade the quality of the HDR image and for this 
reason there are options to Align Source Images 
and Attempt to Reduce Ghosting Art!facts. Tripod 
mounted exposures negate the requirement for the 
former option and., from experience, the latter 
option can cause processing artifacts and is best 
avoided. My personal opinion is that with the 
current state of technology HDR is really only of 
use when photographing static scenes with a 
stable tripod-mounted camera. When 
photographing interiors then the only movement 
related problem that I may encounter is people 
wandering through the scene, in which case I wait 
till they have gone and re-shoot as necessary. 
Tone Mapping the HDR Image The l:-1 DR image 
created from the separate input exposures is a 32-
bit file which will not display correctly or print 
successfully on conventional monitors and 
printers. The file must be processed to reveal the 
inherent dynamic range and to produce an image 
that is capable of being properly visualised with 
consumer screen and ...--rr-... 
print technology. This 
process is known as tone 
mapping and in this 
respect Photomatix Pro 
offers two different tone 
mapping methods, these 
being available via the 
Details Enhancer and 
tone Compressor 
options. 
Details Enhancer is the 
default tone mapping 
method and is the one 
which I prefer to use. It 
has more processing 
options than the Tone 
Compressor method and 
thus offers a greater degree of user control over 
the final image, although if the controls are set too 
aggressively this method is prone to creating 
unnatural looking images and halo artifacts. 
The following discussion of the tone mapping 
process is based on the Details Enhancer method, 
but note that to a large extent tone mapping is 
unpredictable in that a series of settings that 
produce pleasing output for one pa11icular image 
will not necessarily produce equally good results 
with a different image. It is however useful to 
remember that the settings used to process a 
pa11icular image may be saved to disk and then 
loaded as the starting point when processing 
similar images. It · seems to me though that 
experimentation is the key to success when tone 

mapping in Photomatix Pro. 
Of the many tone mapping controls available it is 
the Strength. J,11minosi1y, J,ight Smoothing and 
i.Wicrocontrast settings which most affect the look 
of the final image. The first three controls affect 
the amount of global contrast enhancements in the 
output image, whilst the Microcontrast setting 
affects the amount and transition of contrast at a 
local level within the image, that is between 
adjacent bright and dark areas. 
It is not possible for me to define optimum 
settings for these controls nor even to detail 
typical setlings which I favour, as every image is 
unique and everyone's taste and requirement of 
the final image will differ too. Suffice to say that 
these controls are adjusted on an iterative basis 
with due reference to the preview pane until the 
user is more or less satisfied with the tone mapped 
. . 
image preview. 
The image may then be finessed using a range of 
secondary controls: these include white and black 
point clipping, shadow and highlight smoothing, 
colour temperature and colour saturation. 
Once satisfied with the settings the image is 
processed to apply the tone mapping settings, and 
then saved as a 16-bit TIFF file for fu11her work in 
Photoshop or equivalent as required. 

Post-processing the Tone Mapped Image 
In my early days of HDR processing Twas always 
slightly disappointed with the output from the tone 
mapping process as to me the images tended to 
look a little fiat and insipid. They certainly held 
highlights and revealed shadow detail as 
compared with single exposures but were 
somehow lacking in character. For this reason I 
experimented with post-processing of the tone 
mapped images in Photoshop and gradually 
evolved a worktlow which allows me to add back 
a little atmosphere and visual impact. 
Rather than go into great detail, I will just identify 
each of the main post-processing stages that I take 
a tone mapped image through. Note that each step 
is actioned on a separate masked layer in order 
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that I may control both the image area affected by 
the change and also its strength and visual effect 
by varying the opacity and blend mode of the 
layer. 
Step I - ,"1ferge back the -2EV Exposure 
The -2EV exposure is overlaid on the tone 
mapped image, the layer blend mode set to 
Lighten, and the two layers then flattened. This 
has the effect of brightening up highlight areas 
which may have been left rather tlat and grey in 
the tone mapping process. A comparison of 
figures 2 and 3 shows that both window and table 
cloth highlights are corrected by this process. 
Step 2 - Duplicate h11ckground layer to 11dd contrast 
The background layer is duplicated and the blend 
mode of the duplicate layer set to Soft Light in 
order to increase colour depth and contrast. This 
step usually requires that the changes are 
restricted to specific areas of the image and with 
varying degrees of opacity. 
Step 3 - Dodge and burn 
A new layer is created at the top of the layer stack. 
filled with 50% grey, and the blend mode set to 
Overlay. Local dodge and burn contrast 
enhancements are made as required by painting 
onto this layer with soft. edged white and black 
brushes respectively, typically with an opacity of 4%. 
Step 4 - Add vignette 
f tend to add a subtle vignette to most of my 
interior images, both to concentrate attention 
toward the centre of the image and also to 
accenl'uate the natural fall of light and shade in the 
room. There are many ways to add vignettes in 
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Photoshop but the technique which r favour is 
based on a curves adjustment layer with blend 
mode set to Multiply. The associated layer mask 
may be used to control where the vignette is 
applied. either via a blurred elliptical selection or 
by linear gradients dragged in from each of the 
image corners. The basic vignette created in this 
way may then be adjusted to taste by altering the 
opacity of the adjustment layer and also by 
painting directly onto the layer mask with a soft 
edged black or white brush. 
Jhe Cre{(tion of Composites Much as r enjoy 
photography, l am also something of a computer 
geek and. after 25 years working in computer 
graphics, f really can't resist a good dabble in 
Photoshop. Tt also seems to me that a carefully 
processed HDR image can showcase the beauty of 
an old interior but may not necessarily have 
sufficient visua I impact to hold the attention of the 
casual viewer. The creation of digital composites 
therefore satisfies my own personal fascination 
with digital image manipulation and the pursuit of 
Photoshop excellence, and also adds an extra layer 
of interest to extend the potential audience of my 
images. 
Very rarely do f go out on a shoot with the aim of 
a particular composite in mind, most of my ideas 
coming as afterthoughts once T have processed the 
HDR images through Photomatix Pro. On rnost 
occasions a 'finished' HDR image will sit on rny 
hard-drive for months until an idea pops into my 
head, and l will then go about photographing the 

Continued on page page 26 

DAVE URWIN 

Figure 3: The fi11a/ 
image after finessing in 
J>lmtoshop 
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ROGER HOLMAN ARPS 

The Gigapan Sy 
With discussion of the possible formation of a panorama group within the Society and wondc1 
together, Roger Holman tells us of his experiences with a rather different approach. Roger'~ 
would appreciate its ability to produce huge size images with all the incredible detail that is po 
of Wimborne Camera Club and has been interested in photography since his teens but it was 
Since then he has produced more than a half a dozen landscape books on Dorset, the county Tl" G;gap<m system has three elemeots, 

• A robotic mechanism which will accept a small 
compact camera; 
• Custom software which will happily stitch up to 
hundreds of files together to produce a high 
quality panorama; 
• An ability to upload the resulting images onto 
the Gigapan website for eve,yone to share and 
comment on. 
So briefly that is it .. but the interesting part is the 
robotic camera mount. There arc two mounts. The 
Epic and The Epic I 00 priced at US'.£379 and 
US$449 respectively. On their website there is a 
list of what cameras can be foted to either. 
The operation is very simple. Set the unit on a 
tripod and I.eve] it with the bubb.le spirit. level. Fix 
the camera on the unit. If the panorama has 
foreground that is within 50 feet. ir. is best to set 
the nodal point on the lens correctly othenvise it 
doesn't seem to make much difference. The first 
time it is used, or if you change the zoom factor, 
you have ro inscn,ct the inbuilt computer to 
calculate the overlap it needs to get a good stitch. 
This is ac.hieved by setting the zoom you want and 
recording an image. Then adjust the up button 
unti I the bottom of the picture is where the top 
was. The unit then takes those readings and does 
the required calculations. 
It is best to manually lock the exposure to an 
average of the whole intended picture just as you 
would taking any panoramic shot. ~ow set the rop 
left. point that you want by using the 

up/down/leftirighr. buttons, and then the bottom 
right point. The unit then calculates the number of 
frames that. will be taken to cover that size of 
picture, converting it into rows and columns. Press 
the start button and away it goes, moving and 
exposing until it has covered the whole area - magic! 
You can pause it at any time and repeat a frame if 
someone walks into the shot. You are looking at 
the live view picture all the time. 
You will now probably end up with dozens of 
images which are then put into the Gigapan 
stitching program. It first lays the images out in 
rows and columns which is very handy because 
you can check if everything is in the right place 
and allows you to delete a repeated picture. Set it 

The F.pic Gigapan 
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'Stem 
·ful free, and commercial, software available for stitching images 
: aim is to bring Gigapan to the attention of photographers who 
ssible - but with just a small compact camera. Roger is a member 
not until he retired some 17 years ago that he had time to pursue it seriously. 
in which he counts himself fortunate to live. 

Roger witlt the Gigupan 
whiclt he shares •tJith a 
friend 

to work and go and make a few cups of tea or find 
a good book because you are likely to end up with 
a file size of a gigabyte or more. Lots of RJ\M and 
a fost processor hetp. If it really is a massive file, 
set it to work overnight. With rny computer, 50 
images take about. a hour. 
When the picture has been rendered ir will be 
curved bur. as soon as it is saved in eir.her Tl FF or 
RA. W then ir sr.raightens out. I guaramee you will 
be arnazed at how much det11il there is to see when 
you zoom in and in. 
If you want confirmation go to www.gigapan.org 
and look at President Obama 's inauguration 
picture. You can almost read his speech! I was 
told it was taken using the Cigapan with a 
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compact camera by someone who had not 
operated it before and was ra lked through it on the 
phone. 
The stitching programme is first class and is free 
to anyone who takes the trouble ro download it. Ir 
can of cou(Se be used for images taken by any 
camera. 
Gigapan was not developed with phor.ographers in 
mind but as a means of bringing people r.ogether 
across the globe and because of the incredible 
detail possible, exploring or.her people's worlds 
and environment. I think that is the reason it 
doesn't seem to have been picked up by the 
photographic press. 
Go to www.gigapan.org to learn more. 
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DAVE URWIN 
Continued from puge n 
additional elernents and assembling them as 
required. Very rarely do I resort to the use of stock 
images, preferring to use elements tlrnt l have 
photographed myself as far as is possible, as in 
Sleep Walker below. 

Regarding compositing technique then my main 
objective is to have the final image look as real as 
possible, and certainly to avoid the dreaded pasted 
on look. Jn this respect scale, perspective, 
direction and quality of light, shadows, colour hue 
and saturation are all absolutely key. There is no 
'one size fits all' workflow that must be followed 
when creating composite images, rather it is a case 
of bearing in rnind the key attributes as defined 
above and gradually building up the reality of the 
image on a layer by layer basis. 
The panel of four images shown below illustrates 
this process and depicts some of the stages in the 
progression of a composite image. Top left is the 
starting point where the man and skeleton have 

been brought into the background HDR image and 
scaled and positioned to fit. In the top right image, 
a shadow and shading has been applied to the 
skeleton to give a more three dimensional look 
and (hopefully) a more convincing feeling of the 
object actually belonging in the room. This same 
approach of shadow and shading has been applied 
to the man in the bottom left image, again with the 
aim of bedding the added element more 
convincingly into the underlying scene. finally, in 
the bouom right image, the colour saturation of 
the man has been reduced and reflections painted 
in on a layer above him to give the impression that 
he is in the cabinet rather than pasted onto the 
outside of it. 
Although each and every composite is different 
and is progressed in its own way, l do find that 
there are certain key Photoshop tools and 
techniques which contribute extensively to the 
compositing process and which are repeatedly 
used in all ofmy work. Layers and layer masks are 
fundamenr.al in allowing the image to be built up 
inn progressive and reversible manner; curves and 
hue/saturation adjustments facilitate the blending 
of an added object into its environment: and 
painted shadows and shading with a blend mode 
of Multiply and opacity to suit really do ground 
the added objects and give them a feeling of depth 
and belonging. l would also add that the use of a 
graphics tablet is essential in allowing for much 
greater precision and control when working in 
Photoshop than could be achieved with a 
conventional mouse. 

Resources and .Further 
Reading J recommend 
thiit you download a free 
trial copy ol' Photon mi ix Pro 
from: www.hdrsoft.com 
an cxccllcn t sou rec of 
knowledge with in depth 
FAQs on HOR 
technology, Photornati,~ 
Pro, and has links to 
external articles. 
Plwt0shop ,Haski11g a11d 
Compositing by Katrin 
Eismann is a well written 
book, very readable and 
tnily informative. 

Sta1,,es i11 tlte creatin11 of 
11 digital composite 

Hight: Heriloge 
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PHOTOGRAPmc ALLIANCE OF GREAT BRITAIN 

PAGB 
The PGB is of corse well known but do you want to be kept in touch through its 
electronic newsletter? Just email Rod Wheelans at rotl@creative-camera.co.uk 
The PAGB is very happy for you to forward thee-news to interested parties or to print 
it off for display at camera clubs or other venues. But clearly you should not alter it 
other than resizing if necessary. Here's a sample from the September newsJetter. 

•\•,,11~.-._:. 1"' •"';:·: ::u:n::.-· -:,::-
_ r•••11• ~~;;--.:"'~:;:,:~ -
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The Photographic Alliance of Great Britain 
(PAGB) co-ordinates specific activities for 
photographic clubs in England, Scotland. Wales 
and Northern Ireland. It does this through 15 
geographical regions known as Federations. Access 
to its services and facilities is available through 
membership of a dub that is affiliated to the PAGB 
through its Federation. So, there is no individual 
membership of PAGB. 
The Alliance organises national competitive 
photographic events for its Federations and for 
clubs and offers other services such as Recorded 
Lectures to clubs and its own photographic 
Distinctions (known as awards for photographic 
merit) direct to qualifying club members. You'll 
spot these as. for example, DPAGB. 
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I: The original image 

SIMPLIFIER SOFTWARE 
Alan Dedman has being using "buZZ' software to produce his wonderful landscapes for 
some years. This is no longer available so what can people who want to create a similar 
effect use as an alternative? 

T
he 'painterly' look. Love it or hate it. 
Long. long ago I was greatly taken 
with the works of Constable aml 

Turner and wanted to reproduce the painted 
look with a photograph. More recently T 

found, as T wanted to do landscapes, the 
more I liked this idea. Some landscapes 
simply cried out for it .. or so I thought. Until 
a shore while ago it was produced by using a 
program cal.led ·buZZ', which is a simplifier. 
Unfortunately, or not, the company that 
produced this program went out of bHsiness. 
Obviously, not too many people liked it. but 
T think it still is, and was, a valid means of 
expressing ones personal vision. 
The Simplifier effect is based on patented 
Sieve transform technology, which, 
according to Segmentis (this is the nnme of 
the ·bu/1' company before it changed to 
Fo2PiX), "allows ?n image to be segmentecl 
into its component parts, in order that they 
may be identified, unclerstood, label lecl., ancl 
indexed." In essence, the Simplifier effect 
removes Hnimportant cletail from a photo 
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whiJc preserving colour, focus, shape and 
edge, leaving you with an improved base 
image for applying other effects. You control 
how much or how little detail you wish to 
remove from the original photo by adjusting 
the controls within the Simplifier effect. 
As buZZ is no longer available this will be a 
simple comparison. I leave the finer tuning 
to you. 
The original image for this comparison 
(Image l) is a 'Tiff' file saved at 300 ppi, at 
8 bits. This seems to work best for these 
programs, especially 'buZZ' which will not 
work with rnHch else. 
The second image is Hsing 'buZZ', not the 
·Pro' version. This program has a slider that 
al.lows you to vary the amount of 
simplification you do. T set the slider at 500 
for this image. This is using Simplifier One 
with it applied to both the light ancl the dark 
setting. 
The third image is using 'Topaz·. This 
program, that you have to buy from 
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http://www.topazlabs.com, is 
tbe new kid on the block, taking 
over from 'buZZ'. With 'Topaz' 
you get Jots of differing sorts of 
simplification treatments. This 
is using the option 'RuzSim' at 
its default setting. or should I 
say, at the values it gives me 
each cirne I open it. Needless co 
say, you can make it subtler or 
more pronounced. 
The differences would appear to 
be that the 'Topaz· irnagc is 
more saturated, has more 
contrast and is rnore aggressive 
in its simplification. Even 
pushing the 'buZZ' slider up co 
1500; I cannot get the same 
'look' of the simplification 
between the two. The 'Topaz· 
program does give you controls 
for tbe contrast, saturation and 
detail strength. 
The fourth image is made using 
Simplifier J .22 from Amphisoft. 
With the setting of 5 on the 
square slider. 1\ny lower would 
nol be particularly noticeable on 
a small image. This would 
appear only to be usable with 
Adobe CS2 or CS3 Photoshop. 
It is freely available from 
several plug-in download web 
sites. 
Whilst this is a simplifier. it is 
not comparable with the other 
two. I cannot get a result 
similar to the others with just 
the controls given. 
With "buZZ' I have to add levels 
and curves, in differing amounts 
as and where I want it. 'Topaz· 
would have me work the other 
way, which T am not keen on. 
However, my conclusions are 
chat as 'Topaz' is the nearest T 

can get to 'buZZ', there would 
appear to be no other 
alternative. 'Topaz' does give 
you ocher instant forms of the 
simplifier and docs give a range 
of controls to create the look 
you want. If this had come 
along first and 'buZZ' second, 
we may well be saying that 
'buZZ' was a bit weak. 
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ALAN DEDMAN LRPS 

2: ,Hodijied with buZZ Simplifier 

3: !'vfodified with Topaz 

4: i'l-fodijied ,.,ifh Amphisofi Simplifier 
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Fig11re /:The SJ1ccessf1tl panel 

THE EVOLUTION OF AN 
ASSOCIATESHIP PANEL 

David Cooke worked for over a year on his successful Associateship panel after gaining 
his LRPS. He discusses the process he went through and what he learned on the way. 

I've always been interested in laking 
photographs of people and that's why there are 
no people in any of my Associateship panel 

images. Let me explain. 
Like many others, I took a keen interest in 
photography when I was at school and had a small 
darkroom at home. As time when on, and other 
responsjbilities took over, I let my photography 
slip and ii was not until three years ago, when l 
was given a second hand Nikon D70 that I started 
lo take ii seriously again. Naturally, l turned to my 
favourite subject and started exploring the 
photography of people again. 
I joined the RPS in 2006 and the Digjtal Imaging 
Group a few months later. This last move was 
invaluable as it allowed me to post images on the 
DIG forum and to get comments from other group 
members. I learned so much from these comments 
that I would strongly recommend it to anyone who 
wants to improve their photography. 
Soon my photography improved and, with the 
help of John Long ARPS, I started to put together 
a panel for submission for the Licentiateship. All 
the photographs in the final panel were of people 

JO 

and I achieved my Licenliateship in Febrnary 
2008. This was a major achievement for me, one 
which, many years ago, I thought was an 
impossible dream. 
Encouraged by other DIG members on the forum 
to use this as a stepping stone rather than an end in 
itself, I started thinking about trying to obtain the 
Associateship. But what would be the best way to 
go about it'! 
I decided to start working more in projects and 
thought of a few subjects T could explore. One 
decision l made early on was not to include any 
people in the projects, hence my opening 
statement. This was very restricting for me and 
that restriction was deliberate. l thought that by 
exploring something without people 1 would learn 
much more than by sticking to my favomite 
subject. 
l thought of a number of projects 10 work on, 
including one on The Chmch of St Thomas the 
Martyr in Bristol which was eventually the 
subject of my panel. 
St Thomas the Martyr is the sort of church you 
could walk past without noticing it is there. ll's on 
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Figure 2: OrigiJJa/ pane/for the ovorhshop 

the main road and the outside blends in with its 
somewhat dowdy surroundings. (t had graffiti on 
the walJs (this has now been removed) and weeds 
growing in the cracks in the concrete. 
I didn't notice it at al I until one day, l saw a board 
in the street saying 'Church Open'. I went in, and 
inside it is a different worJd. Looked after by the 
Churches Conservation Trust, the main part of the 
building is magnificently kept - grand, clean and 
welcoming. Upstairs, in a less public area. there is 
a room once used by an art group and now 
containing the remnants of their work. 
I was struck by the similarities and differences 
between various aspects of the building and its 
surroundings and set about ttying to capture this. 
l started work on the project in April 2008. I put 
images I thought were good on the DIG forum to 

get conunents and by October 1 had put together a 
draft panel to take to a distinctions workshop 
(Figure 2). At this stage J was still uncertain as to 
which distinctions panel to go for, in particular 
whether to go for Visual A11 or Contemporary. I 
feel that Visual Al1 is my artistic home but my 
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Figure 3: Draft panel ajler subsequent meeti11g 
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panel was intended to tell a stoty so maybe 
contemporary would be more appropriate. 
The draft panel consisted of 15 images arranged in 
two rows. This fitted with my original intention to 
convey the similarities and differences by forming 
a link between the images on the top row with 
those immediately below them: both in substance 
and in form; e.g. the bible and the graffiti on the 
outside walls, shadows amongst the pews and 
shadows formed by the fence outside, the opulent 
candle holder by the altar and the dilapidated 
standard lamps in the art room. 
l found the workshop extremely helpful. The 
ARPS advisor on the day was John Chamberlin 
fR_PS. He told me that the Visual Art panel would 
certainly be interested in seeing my submission 
and that l had a good basis for one, although there 
was still some way to go. In particular, I had some 
images which were not as good as they should be. 
This was because ( was t1ying to tell a particular 
story and I had fallen into the trap of using less 
good images to do that because they fitted with the 
story. Furthermore, there were problems with the 
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layout and overall feel of the panel. It didn't work as 
well as it should, for example because the bright red 
aisle stood out and drew attention away from the rest 
of the panel (Figure 2, fourth image from the left on 
the top row). I. al.so realised at this stage the 
importance of tbe way the panel is laid out in 
maximising the impacr of the images and just how 
difficulr this skill is. 
IJ l were to go to rhe Visual Art panel then I also 
needed to concentrate more on the 'artistic' side of 
my images; good use of light and form for example. 
We agreed tbat I would rake several more images 
then meet again to discuss them. 
Suddenly it all became much more difficult. With any 
subject it's easy ro get several good, if nor 
predictable, shots but it's when you've exhausted all 
these that it gets difficult. But rhat is also the time 
when you get more creative. Several times I thoughr 
rm never going to get another shot out of this then 
some came which were much better that any of those 
I'd taken previously. This was a potential problem in 
itself as the good images made some of the others 
look distinctly mediocre. But it's a good thing as ir 
showed that my work was improving and if some of 
rhe images J already had looked mediocre then they 
needed ro be replaced by belier ones. 
I also started ro ftnd the limitations of my camera. ft 
just couldn't cope wirh the high contrast lighting in 
the cburcb, especially on sunny days. Tt was at this 
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stage that J started to take High Dynamic Range 
(HDR) images and J learned a lot abour how to do 
this successfully as a result. Six of the final panel 
images were taken using HDR techniques. 
By .February 2009, I'd put together a second draft 
for discussion. f was much happier with this but it 
srill wasn't up ro the required standard. One 
problem l had was rhat the church was only open 
berween 10:30 am and 2:30 pm on Wednesdays 
and this restricted rhe lighting conditions f had to 
work with inside rhe building. For example, the 
angle ofrhe light coming through the stained glass 
windows limited what in rhe church was suitably 
lit to photograph. However, the angle did vary 
between seasons, making rhis something of a long 
term project. Another was that the lighting in the 
images I. had taken outside was a bit flat. The 
images in the draft panel after rhis discussion are 
shown in Figure 3. 
More images were needed, not only to fill the two 
gaps on the top row bur also ro address the 
problems mentioned above This meant my finding 
them by being more creative with angles and use 
of available light. 
I took more shots and, after further discussion, [ 
put rogerher the successful panel (Figure I). 
Only five of the images originally taken to the 
workshop survived and made the final panel, 
whilst eleven of those kept after the subsequent 
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meeting did so. 
( was awarded my Associateship in June 2009 and, 
as you may imagine, it was a great relief that the 
panel succeeded. 
A big bonus for me was that the Churches 
Conservation Trust asked me to put on an 
exhibition of my work at the Church which ran 
from 25 June· 30 July 2009. I also put together an 
electronic catalogue of the exhibition which you 
can download free of charge from: 
http:/ /sitcs.googlc.com/sitc/ lights had can dco n t rasts/ 
The first fifteen images in that are those in my 
successful panel, the remaining six were 
considered at some stage in the process but didn't 
make it into the final panel. I'm extremely grateful 
to the Churches Conservation Trust for allowing 
me to take photographs in the church and for 
agreeing to my publishing them. 
All in al I it's a long, long process (for me anyway) 
but a very educational one and I hope that by 
giving you an account of the process I went 
through, those who are thinking of subrniuing a 
panel for their ARPS will be encouraged to do so. 
I can honesty say that even ifl had not succeeded, 
despite the undoubted sense of real 
disappointment I would have felt. l learned so 
much and my photography developed so much 
that it still would have been well worth it. 
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THE COOKE CHALLENGE 
This time we have four more images from DIG members who explain how they created 
them. I hope you'll find these interesting and helpful techniques to use in your own 
photography. If you do, why not join in and send me some of yours? Email me at: 
digitchallenge@gmail.com 

T!te Thistle Fo11ndatio11 montage 

The Thistle Foundation montage by Andy 
Wanstall 
The Thistle Foundation is a purpose built estate 
initially for injured veterans of World War 2. Over 
the years the premises have been open to people 
with various illnesses such as M.S. and 
Parkinson's Disease. 
The beautiful Robyn Chapel, which caters for all 
religious beliefs, is situated in The Thistle 
Foundation grounds and is a memorial dedicated 
to Robyn Tudsbery, the only son of Sir Francjs 
and Lady Tudsbery, who sadly lost his life duriog 
the last days of WW2. 
The image was created as follows: 
I. Select and import the photo of Stonework and 
duplicate same. 
2. Import photo of Robyo Chapel. 
3. Use rectangular marquee tool to make a 
selection aod feather by seven pixels. 
4. Copy and paste. Put the selection into position 
on the Stonework. 
5. Use drop shadow by ten pixels from layer 
menu for effect. 
6. Next select the Thistle Foundation Sign. 
7. Use the elliptical marquee tool set to tweoty 
pixels for feathered effect. 
8. Copy and paste. Position onto Stonework 
9. Next, place the Stained Glass Window photo 
into position and below the copy of Stonework 
layer. 
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Stonework 

Robyn Chapel 

I 0. Highlight the Stonework layer and set 
opacity to 50% You will see the Stained Glass Thistle Fo1111datio11 sign 

Cross picture below. 
11. Next, keep 'on' Stonework layer and select 
brush tool. 
12. Set brush to 50% grade. 
13. Find layer from menu then layer mask, the 
Stonework photo,> reveal all. 
14. Now set the black and white from tool bar 
and set to default (press 'D'). 
15. Use the brush tool as previously set (50%) 
and brush over the Stonework to reveal the 
Stained Glass Cross below as required. 
Occasionally check and reinstate the Stonework 
picture to 100% opacity to view the design of 
the Stained Glass Cross. Use the letter 'X' on Srai11ed glass wind0""' 

the keyboard to restore the 'white brnsh' if too 
much stonework has been removed and 'brush
in' the required stonework to suit. 
16. Lastly, select the photo of the Wrought-iron 
Tree with Robins. 
17. 1 Jse the magic wand tool to select the 
majority of the selection then fine tune the 
selection by using either the eraser tool or lasso 
tool to remove any stray pixels. 
18. When satisfied with the selection again use 
the magic wand tool and re-select and inverse. 
19. Place the picture into position on the 
Stonework. Wrought iron tree with 

robins 
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It's Not a Lamppost by Malcolm ((jtto 
ARPS 
The time window in which this image was 
created was very long. The original idea 
came quite quickly when T shot the stilt 
walkers at the Winchester Hatfair in July 
~006. l was able to create a folder of many 
images as there were five girls in the 
group. Finding the Dalmation dogs took 
much longer, in fact I finally succeeded at 
Widdecombe Fair several months later on 
~ day when the weather was very 
inclement. I shoe the Tudor buildinus at 
Potterton in March 2007. l think the final 
version went "live" in April 2007. 
Photoshop CS and CS3 were Hsed. I 
prefer to use layer masks co select the 
various component images after making a 
rough selection with the polygonal lasso. 
Note: T save all cut out images in a folder 
f name CS3 Bits 2009 (I create a "bits" 
folder each year)This ensures that l can 
use them should I wish for ocher 
creations. Each component image was 
dragged into the main image where it 
became a layer and was then re-sized 
using Edit> Transform>Scale. 
The image was built up as shown in the 
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Layers Palette but layers were not 
necessarily introduced as numerically 
listed. 
Layer I. White base layer 
Layer 2. Grey Grad with some Noise 
added for the street surface. l required 
this area to be relatively minimalistic to 
emphasise the figures l intended to 
introduce later. 
Layer 3. The houses, were added and 
Find Edges applied. 
Layer 4. Convert the houses to a black 
and white sketch using a Channel Mixer 
adjustment layer. 
Layer 5. A general Clean Up layer. 
Layers 7,9, 13 and 15. At this point the 
cut out images were dragged in from che 
"Bits folder'' and re-sized. 
Selective Curves adjustment layers were 
applied by means of the fol lowing layers. 
Layer I 0. To lighten the 2 girls' faces, 
Layer 11. To correct the 2 girls' slightly 
burnt out hands. 
Layer 14. To Jighten the entire RH girl 
who was slightly under exposed. 
Layers 8 and 12. For the girls' shadows 
the shapes were selected and copied from 
the original images, re-sized and filled 
with black and the opacity was reduced to 
suit 
Layer 6. I painted in the dog's shadows. 
Layer 16. Colour Balance Adjustment 
layer to correct a slight magenta cast 
Layer 17. Finally a Grey Grad was added 
to the sky. 
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Reflecrio11 

Reflection original image The Ludy Train Driver original imuge 

The Lady Trui11 Drfrer 
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Rellection by Jean Pain LRPS 
The image was taken in the Lake District at 
Great Woods in Borrowdale, directly into 
water, which is a subject I love to take. 
As you can see from the original image, I first 
of all cropped it to a square format, because l 
felt this was a stronger composition. 
I then made a background layer, and 
introduced a small amount of Gaussian Blur 
to soften the image slightly and took the 
opacity down to approx 70%, then generally 
lightened the image to give a more soft pastel 
feel, and printed it on Permajet Oyster Paper 
to give a texture to the whole subject. 
As you can see very little has been done to 
this, just softening the whole image and 
making it shades of pastel, which made the 
whole subject more interesting. 

The Lady Train Driver by Ron Pain LRPS. 
The image of this lady train driver was taken 
at the Sherringham 40s weekend. lt is a good 
place to get some candid photos and a great 
day out if you are a train buff. 
As you can see from the original image, the 
first job was to crop the shot to simplify it and 
concentrate on the lady but still show her in 
the cab of the train. 
The day was very contrasty as you can see 
from the original image. The shot was taken 
in raw format. In CS2 browser, using the 
preview shadow and highlights boxes, l 
moved the exposure and shadow sliders to 
remove the burnt out and undere,xposed areas 
(as shown by the red and blue wamiogs) 
I then opened the image in Photoshop and 
gave the image the final touches, removing 
small distracting details and selecting the side 
of the train and making it darker. 
The changes l have made to the original 
image have lifted it from a quick grab shot to 
one I am happy with. 
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WEBWISE 6 with David Cooke ARPS 
All the Webwise material is on the new DI Group Forum which is located within the main RPS 
Forum. You'll need to register to make comments and to contribute. Details of how to do this are on 
the main RPS DI group page at http://www.rps.org/group/Digital-lmaging. Please do make a 
comment on the Forum or email me at digitwebwise@gmail.com to let me know how useful (or not) 
you found the sites recommended. And please do recommend sites you've found interesting yourself 
so other members can share rhem. 

Welcome to the sixth edition of Webwise. This 
time we have a site covering photography tirs 
and tutorals, two sites recommended by Mike 
Arnison LRPS and another Dl Group 
member's website. l hope you find them all 
interesting and useful. 

The Amateur Snapper 
htt p:i/www.amateursnapper.com/ 
l came across The Amateur Snapper Website 
using 'SturnbleUpon' (recommended in 
Webwise 4). The sire has phorograrhy tips, 
trick and tutorials covering a wide range of 
subject areas. Tt\ well laid out and the content 
is well written. Definitely worth a look to tind 
our how to do things or jusr to reinforce things 
you already know. 

Next we have two sites recommended by Mike 
Amison LRPS. 

The Cloud Appreciation Society. 
http://cloudap1)reciationsociety.org/ 
The Cloud Appreciation Society site is all 
about identifying and photographing clouds. lt 
has a cloud gallery where you can see some 
excellent photographs of clouds submitted by 
members. You can search photographs by 
cloud type and photographer's name. The site 
also has a cloud of the monrh feature, music to 
watch clouds by. and cloud and art poetry. It's 
a fun site with lots of intersting things to enjoy. 

PE-rcE-pTool 
http://www.georgedewolfe.com/perceptool.html 
PercepTool is a Photoshop plug-in which, 
according ro George DeWolfe's website 
"works with the luminance image we get from 
the camera and corrects it to look lik.e the 
luminosity percept produced by the visual 
cortex of the brain'·. The website has examples 
of images before and after processing and yon 
can download a 30 day trial version of the 
software. A free pdf file of the first two 
chapters of DeWolfe's book 'B&W Printing' 
that cover where PercepTool came from and 
how it works is also available from the site. 

Brian Eacock ARPS 
http://www.E-acock.co.uk 
Brian Eacock ARPS is a member of the DI 
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Group. His photography covers a wide variety 
of subjects including nature, bridges, 
landscapes, panoramics and people, both in 
colour and mono. As he says on his website, 
'They are a cross secrion of subjects because l 
simply like to shoot whar l see'. 
Brian took up photography in a serious manner 
when he retired. He bought a computer and 
became more aware of the opportunities of 
digital photography, so he decided to take a 
short course in digital imaging. 
Then he joined Beacon Camera Club and 
really got the bug, having seen what could be 
achieved. He discovered that what he had 
thought was a good photograph did nor meet 
with the judges' thoughts. 
Since then he has had three changes of 
computer, three printers ( each bigger, better 
and more expensive!) and 4 camera upgrades. 
Brian was awarded both his LRPS and ARPS 
at the first attempt, the latter in September 
2008. 
Do have a look at his site. There are some 
lovely images there and I'm sure you·11 find 
something to interest you. 

An invitation 
Jf you'd like yonr website to be featured in 
future Webwise articles then please email me 
ar digitwebwise@.gmail.com with details of 
your site and let me have a few words about 
your rhotography. lr could help to put you in 
touch with like minded photographers. 
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NIKON FLAGSHIP D3X 
IS 24.5 MP FULL FRAME 
ENOUGH FOR YOU? 

The autumn of 2007 saw the introduction of l\ikon 's first full frame FX camera, the 
amazing D3. \Vith 12.1 Megapixels it repl.aced the D2x while the new semi-pro Nikon 
D300 12.3 l\tlegapixels DX replaced the D200. Vice-Chairman Graham \Vhistler, a long 
time Nikon adherent and commercial studio photographer, reviews Nikon's latest beast 
for DIGIT. See page 47 for details of the workshops that Graham is organising in 
Cheltenham next year, and the back cover of this issue for the booking arrangements. 

I tested the D3 at the time but it is very much 
aimed at the press. sports aml wild life 
photographers: Bob Pearson FRPS has more 

than covered its world-leading high speed/low 
noise abilities in DIGIT for us. At the time l felt 
that the D2x would still cover rny needs for studio 
photography as 1 have little demand for high ISO. 
However the compact D300 with the 18-200 AF
S lens was a very good upgrnde from the D200 
and as I have done a considerable amount of air 
travel in the last I~ months it has proved to be an 
ideal travelling camera, producing high quality 
results and low noise even at 1600 ISO. 
ln December 2008 Nikon finally announced the 
new D3x FX (full frame) with a 24.5 MP all new 
CMOS image sensor producing 6048 x 4032 
pixels 14 bit images. 

Studio portrait with 
detail enlarged 

The NEF (RAW) files are 35.6 MB each requiring 
a large amount of computer processing power and 
storage space. The amount of very fine detail 
recorded is amazing but only the very best 
professional lenses will <lo. Nikon's new 14-24, 
24-70 and I 05mm macro AF-S lenses were 
designed with the D3x in mind. T had purchase<.! 
these in early 2008 but was in for a shock: the D3x 
body UK launch price was £5,500, compared with 
£3,000 for the D3. By February 2009 prices were 
down slightly and reviews were all goou. I had to 
get onel 
As Nikon's main rival, the Canon EOS-IDs Mk 3 
21..1 MP, was still selling for £5,200 lhere were 
few grounds for complaint. By .Angust 2009 both 
DJx and IDs Mk3 bodies were still selling ar 

about £4800. 
The new camera is very similar to 
the D3 and apart from the suffix x it 
would be hard to tell them apart. 
Both cameras share the same robust 
weatherproof bodies and near 
indestructible shutters. For me the 
D3x is a huge step up from the D2x. 
Image quality is outstanuing, anu the 
fine detail is more than most 
photographers would ever need. 
Processing the 35.6 MB NFFs needs 
a powerful anu fast computer and 
Nikon's Capture NX2 software 
slows up if you have too many 
images open at the same time. 

The files open in Photoshop as 16 bit l 3~) MB Tiff 
files, so you need plenty of RAM and a very fast 
graphics caru. Even at JOO% in Photoshop you can 
only just sec the very fine pix.els. Blacks are very 
pure with no noise at all up to 400 ISO but even at 
1600 JSO shauow noise is sti 11 wel I controll.ed and 
at A3 prints arc still of very high quality. I have 
not tried the D3x beyond 1600 ISO but reviews 
say this is where the D3 scores, impressing every 
sports and wild life photographer who has used 
one. Even the new compact Nikon D700 12.1 MP FX 
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camera that came out in the middle of last year 
aimed at the semi-pro market is also a world 
leader in terms of high quality ISO performance. 
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will not dwell too much on technical 
specifications as all this can easily be found on 
Nikon's web site. As a studio camera it would be 
hard to fault and results are now getting close to 
top end digital backs on medium format cameras. 
The DJx is much easier to use than any medium 
format. camera and has a far wider range of top 
quality lenses. The DJx can also use DX lenses in 
a special crop mode. 
Auto focus is fast and accurate with 5 I focus 
points (including 15 cross-type sensors for action 
tracking). Focus tracking is automatically 
activated with AF-S lenses according to subject 
stanis. After seven months using the D.h I have 
yet to have an unsharp picture even in poor light. 
Frame rate is slow compared with the D.1 but for a 
studio camera 5 frames a sec for 12 bit NEFs is 
adequate but at 2 frames a second with 14 bit 
N.F:fs this may not be fast enough for a fashion 
photographer. 
Like the DJ lhe camera takes two compact flash 
cards but has increased buffer size to cope with 
the larger files. To take full advantage of the fast 
processing you need ultra fast cards. I use a pair of 
San Disk Extreme l V 8 GB cards. Each card holds 
J 54 14 bit NEFs or 200 J 2 bit :-.IEFs. 
The l 005-pixel RGB sensor JD Matrix exposure 
metering system is hard to fault and as yet r have 
not needed to use the spot or centre weighted 

Below: 1/160 atfl/6 at 
ISO 100 
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Nikon D3x FX 

Detail enlarged shows 
the definition achieved 
with the Nikon 

modes. The dynamic range is very high with first 
class retention of highlight detail and accurate 
colour reproduction. An amazing amount of 
highlight and shadow detail can be recovered from 
over or underexposed NEF files in Nikon Capnire 
NX2. So far T have rarely needed to correct 
exposure in post production. 
The bright large viewfinder is I 00% accurate and 
easy to use: the larger f-X field is a big 
improvement after years of using DX format 
cameras. The 1 inch 929.000 dot LCD Monitor is 
ultra high definition but still proves difficult to see 
in bright sun'. 
The LCD glass is said to have great darnage 
resistance but I have sti II fitted a third party see
through cover. 
Like the D300, the D3X has Live View allowing 

you to compose and shoot using the monitor: 
l have yet to find rnuch use for this feature. 
Is this tbe camera for you? lf you are into 
landscape or still life studio photography and need 
the fine detail of a 4x5 inch view camera you will 
be very pleased with the D1x. It is a large 
professional DSLR needing a full range of top 
glass to exploit its full potential. It is aimed at the 
advertising, commercial or industrial 
photographer who in the past would have used 
srudio large format or medium format cameras. It 
is able to produce very high quality large files 
needed for top quality reproduction. As these 
reproductions indicate, the recording of very fine 
detail is amazing. On the other hand_. if your aim 
is to produce top quality A1 exhibition prints there 
are any number of first class cameras in the 12 MP 
range capable of doing all you need for 20% of the 
cost of a D3x body. 
The latest development from Nikon and other 
carnera rnakers is to upgrade rnodels to include 
high definition movie recording. Canon with its 
full frame 5D Mk 11 and 500D, then Nikon with 
the D90 and now the upgraded D100s (pushing 
the price up from .£ 1.100 to£ 1,500) which is due 
out soon. 
Do we need this added feature? I for one will not 
repl.ace my D300 and will continue to shoot 
moving images with a camera dedicated to that 
function. I am very glad that Nikon has not gone 
that way with the D1x and spoilt the best camera I 
have ever owned. 
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TONY HEALY ARPS 

40YEARS ON 
You can't have missed all the nostalgic excitment of that first lVloon landing all those 
years ago. You no doubt remember where you were - assuming you're old enough - but 
here's a unique photographic memory from Tony Healy. Australia was fortunate 
enough to be facing the Moon at the critical time and seized the chance to make history. 

Prior to the moon walk, the photographic 
deparlmcnt of eve1y newspaper in Sydney 
comprised small cubicles where every 
photographer did his own thing to produce 
pictures that the editor would deem suitable 
to publish. Any of those photographers who 
happen to be alive today have a plethora of 
stories on the special personal techniques 
they used to gee the picture from film to 
editor's desk, with not always successful 
results. 
ln 1969 the edifice at 2 Holt Street. 
Suny Hilb was Mirror Newspaper 
Ltd. They had tendered, and won, 
the syndication rights for the 
pictures coming from the Parkes 
dish to the OTC Centre in 
Paddington before being sent 
on to Houston Control in 
Texas. The images were to 
be displayed on a special 
TV monitor and 

The camera took a picture eve1y ten seconds or as 
required. The 70 rnm back held l5 feet of film 
sufficient for 50 exposures. 
The Mirror photographic manager, Max Ross. 
realised that apart from the fact they did not have 70 
mm processing equipment, they could not possibly 
expect to cope with chat volume of film processing 
and volume printing within the expected time 
frame. 
Kodak Australia/Asia had just introduced a film 
processor that would process film up to lO inches 
wide, dry to dry in just six minutes. News Ltd 
approached Kodak with the proposition to install a 
processor at the Mirror to use for 1his purpose. The 
installation would make the Mirror the first 
newspaper in Sydney co install machine processing 
in an Australian newspaper. The installation was 
started on Wednesday 16 July and a fellow Kodak 
representative and l were given the job to make sure 
the processor was operational for the first rolls of 
film on Monday 21 July. 
l drew the short slraw co be the person to feed the 
first roll of film into the processor. To stand there 
with that roll of film in my hand and realise the 
ramifications if Murphy's Law was invoked was a 
bit daunting. Fortunately the whole exercise went 
like clockwork, despite some drama behind the 
scenes - and the world received the picrures. 
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Tony's 011 the left of the 
picture in the newspaper 
cuffing above. And, on 
the right, here he is today 
on a recent trip to Alaska 
captured by wife .!01111. 

His df~ital hack l.ei<:a is 
at tlte ready. Watch 0111 

for a future DIGIT 
article from Tony 011 this 
fu111astic cruise where 
they enjoyed wildlife 
ranging across hears, sea 
otters, puffins, orcas, 
whales, sea lions. 
11101111tain goats, 
dolphins, bald eax/es, 
birds galore und of 
course glaciers. A great 
wildlife fl'ontier says 
Tony. 
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CLIVE HAYNES FRPS 

EVEN SHARPER 
LUMINOSITY BLEND MODE AND 

SELECTIVE SHARPENING 
Following his Start Here article in the spring issue of DIGIT this year (No 41) Chainnan 
Clive Haynes takes us through more sophisticated sharpening techniques. Although Clive has 
retired from full time college teaching he is active in the club circuit, lecturing and judging 
and sits on the L panel of the Society. His website at www.crhfoto.co.uk contains a wealth 
of infonnation on Photoshop routines, including sharpening. 

The starting image: 
a studio portrait of The 
Fisherman 

luminosity /1,fode 
I ,_nf ----;;;;;;;, 

In this article l 'm exploring two methods of 
refining the sharpening process. I ,ast rime I 
touched on the benefit of using this filrer in 

Luminosity Blend \1ode and now J will expand on 
that and also explore how to apply sharpening to 
selected areas of an image. 
Unsharp /Wash using Luminosity Blend ,4fode 
When sharpening it's frequently advisable lo 
avoid sharpening the colour information within an 
image as this can reveal an increase in visible 
colour noise. Sharpening is often better carried out 
in the monochrome portion of the image known as 
Luminosity. The I .uminosity (I .ightness) content 
of the image provides the essential structural 
detail of the picture. To sharpen the Luminosity 
content only, copy the image to a new Layer. 
Change the Blend Mode of this Copy Layer from 
Norma.I to Luminosity. To do this click on the 
drop-down arrow next to Normal at the lop left or 
tl\e Layers Palette and from the drop-down menu 
list of Blend \1odes choose Luminosity at the 
bottom - see screen grab on the left. 
Set Unsharp Mask to an appropriate amount for 
the image. Careful examination will reveal a lack 
of colour noise. 
Colour Noise may be difficult to see. However. 
magnifying a portion of the image allows us to see 

this annoying result. Even if the noise generated is 
small it will begin to erode the quality of the 
image. If, as serious photographers, we wish to 

have consistent guality throughout our workflow, 
attention to detai I is essential. Using a small 
portion of rhe example image, the screen-grabs 
that follow illustrate how using Luminosity Blend 
Mode successfully eliminates colour noise. The 
examples are all captured at 500% on-screen 
magnification. This large magnification better 
illustrates the problem and .its effect upon image 
fidelity. To further understanding and as an aid to 
comparison. the amount of USM sharpening is 
deliberately excessive, set ar 500%. 

Abo1,e: Unshnrpene,I ori1:inal. 5(1{}% an-screen 
magnification. 

Abave: Sharpened with US.41 at Amount 5()/)%, Normal 
Blend /1,fode at 500% on-screen magnification. Notice 
the colour speckling in the eye.\, upper eyelid, rim of 
finger, in dnrk areas, amongst the hair nnd pin/,. 
looking flesh-tones. 
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improvement. 

The Ad11antages of Selecth1e Sharpening 
Sometimes we wish to sharpen only part of the 
image. This, of course, can be done by first 
selecting and feathering rhe appropriate area then 
applying a sharpening filter. However. for more 
subtle effects and to keep our options open a more 
sophisticated method is recommended. This is 
simple to do and uses a Layer Mask. 
The first step is to duplicate the image. To do this 
quickly within the Layers palette, drag the image 
layer (probably labelled Background) to the new 
layer icon at the base of the layers palette. 
Alternatively, use the route from the top menu bar. 
choosing Select> All, Edit> Copy, Edit> Paste. 
Sharpen the image on the new layer to the 
appropriate amount. A popnlar method is to use 
Unsharp Mask available via Filters > Sharpen > 
Unsharp Mask. 
The next step is to hide the effect you have just 
created. So keeping the same layer active, go to 
Layer> Add Layer Mask > JJide All. The layer 
mask thumbnail on the layer appears as a black 
filled rectangle. 
Alternatively, click on the Layer Mask icon ( white 
circle in a grey rectangle) at the base of the layers 
palette. However. you'll need to hold down the 
Alt Key as you click to produce a Hide All mask 
(not using the Alt Key gives the Reveal All mask). 
The Layer Mask thwnbnail will appear filled with black. 

Layer Mask Icon 
(Black) Layer Mask 

With the foreground colour set to white and a 
suitable brush chosen, the layer mask can be 
stripped away to reveal the sharpening applied. 
To reverse the operation, choose black as the 
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foreground colour and as you painl the area will be 
filled in again. 
Depending on the brush tool selected, difforcnt 
pressures or opacities may be applied to rnakc the 
effecl more subtle. You may return to the layer 
mask at any lime for more adjustments. 
Note: For all Layer Mask operations you must 
activate the layer mask. Do this by clicking inside 
the layer rnask thumbnail rectangle in the active 
layer. To return to normal layer mode, click in the 
image thumbnail in the active layer. 
When you are satisfied with your image and the 
adjustments you have rnade, to reduce file size the 
sharpened layer may be merged with the original 
image. 
Selective sharpening is a highly effective method 
of not showing sharpening artefacts such as halos 
and the sharpening of unnecessary and 
inappropriate areas. 
The two example images below illustrate before 
and after sclccrivc sharpening. Notice how in the 
lower example, where 
selective sharpening has been 
applied, sharpening to the • 
eyes. eyebrows and parts of the _,, 
beard lend emphasis and 
character. 
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BREAKING THE LINK 
Monochrome prints are not colour pictures with the colour taken out 
says Andy Beel FRPS, an exponent of moody mono. DIGIT featured his work in the 
spring issue of DIGIT in 2008 (~o 37). ~ot surprisingly, he's a firm believer in the 
adage that Pictures are taken but photographs are made. 

The phenomena of de-saturated colour fiks 
are regularly seen in club circles 
supposedly masquerading as black and 

white prints. The expressive monochrome print by 
necessily does not rely on the mimicry of the tones 
and the tonal range of a scene as found in nature. 
A big step forward is made when the printer (the 
person not the machine) of the photograph realises 
the tonality of the original scene as found in nature 
is not necessarily linked to the tones of the 
expressive black and white print. 
Austrian photographer Josef Hollehner makes this 
point very well in his studies of the Icelandic coast 

.... 

Above: The origi11al colourfile 
and a mmw version with the colour take/I out 

Lep: Thefi1w/ expressive monochrome print 

which you can see on his website at 
www.josefhoflE-hner.com/pu l>lications.html. In 
his stunning work he largely disregards the mid
tones (middle greys) relying on very controlled 
and separated highlight tones and solid blacks. 
This is not describing the landscape as it is but 
elevating it to art through the use of craft. 
The key word here is expressive. We are not 
attempting to record and describe reality as 
pictorial photographers. 
This is a fundamental point. The purpose of the 
expressive pictorial print is to communicate with 
the viewer at an emotional level what we saw and 
felt and not merely to describe how something 
looks as a record. 
The expressive print also takes on an additional 
dimension which comes from the philosophy and 
attitude of the printer. The printer sees the original 
digital negative as a print that has only been 
designed to its concept stage. All other design 
decision are yet to be taken in the various stages in 
the process of coming to the final expressive print. 
A point made by many authorities is that pictures 
are taken but photographs are made. 
The preparation and production of the expressive 
digital monochrome print in its editing stages will 
require the same degree of dedicarion, application, 
skill and experience that has always been vital to 
the darkroom exhibition print worker. 
Andy is a fotospeed-sponsored lecturer and you 
can see more of his work at: 
http://www.fotospeed.com/gaJlery.asp 

RPS DLGLT Maga:doe Autumn 2009 



PORTRAITS, FASHION AND 
NUDES 

This exciting weekend workshop will he leu 
hy Grah<1m Whistler rRPS for studio 
portr<1its. Clive Haynes FRPS will cover 

RAW files and Photoshop; <1nd Sirnon W,1ldcn, 
principal photogrnpher <1t Cheltenham Film 
Studios, who is well known for his work.shops at 
the studios, will cover fashion and nude 
photography. 
There's more inform<1tion on the back cover with 
booking details. 
You will be working with professional models ,1nd 
you will learn how to m<1k.e poitraits ,1nd figure 
studies like these exarnples. 

Bille. Drape by Simon Walden 

Simon Walden 

Numbers are limited to just 36. You will work in 
groups of nine, taking part in four workshops each 
day. Both Canon and Nikon DSLRs users will have 
cxpe1ts on hand to guiue them. 
You should hring your own laptop and DSLR. 
PennaJct arc supporting the event with printers anu 
paper to print rnembcrs' pictures. 
The studios arc just one minute from Jl I on the M5 
with ample parking. Lunches are available at 
reasonable cost and a Travel Lodge (the hest deals are 
available 011 their wehsite) <1nu other reasonably priced 
hotels are nearhy. 

Pltotosltop Soft Focus by Clive Haynes FRPS 

For more information see back cover or contact: 
Graham Whistler FRPS, 9 Cherrygarth Road, Catisfield, Fareham, Hants POJ 5 5NA 

Email: graham@gwpmultimedia.com Phone 01329 847944 
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The Old SehooIH~Smetbwick Photo Society at Churchbridge, Oldbury, West Midlands B69 2AX 
Easy accoss front MS, J~ 2 by car with ample parking, and by public transport from Birmingham International or 

New Stteet and S-a-..dwell and Dudley stations. See http://www.theoldschoolhouse.com for ~ and routes. 

Reality and musion 
Digital. imaging illustrator and Photoshop special-techniques and amazing manipulations specialist Steve 
Caplin presents an outstanding prograrmne. Steve's books - /low to Cheat in Photoshop and Art and Design in 
Photoshop amongst others - are well known. Be there for the opening of the International Print Exhibition; print 
competition with p.rizes; hear Steve on the ethics of photographic manipulation with current and historical 
examples; assessment and constructive advice of your own manipulated prints and images; and a Photoshop 
workshop demonstration and question session to round off an ente11aining and practical event. 

PROGRAMME 
1000 onwards Coffee and biscuit and a chance to see the RPS International Print Exhibition on display. 
Members' prints displayed for instant competition. Book your ticket with the Society 
1045 RPS President opens International print Exhibition at receptwn@rps.org 
1100 Introduction and judging of prints. or phone 01225 325733 
1130 Steve Caplin on Reality and Illusion: Staging, Manipulation and Photographic Truth 
1300 Lunch - Full Bar Bring your own or pre-order sandwiches 
1400 Steve Caplin assesses members' prints, and images submitted electronically, with manipulation or montage 

1500 Steve Caplin on Photoshop BRrNG YOUR PRTNTS ;'\ND SE~ IMAGES ELECTRONICALLY 
1630 Questions and discussion Full infom,ation available from the DT Group website at www.rps.org in Events or 
l 700 Tea and biscuit and close email to editor@digit.rps.org 

Portraits, Fashion and Nudes 
See below and inside back cover of .DJGJT for more details. To reserve a place contact Graham Whistler at 
graham@gwpmultimedia.com or phone 01329 847944. £50 deposit required and balance by 1 February 2010. 

This weekend workshop, where there are just 36 places, will be led by Graham Whistler FRPS (studio 
portraits), Clive Haynes FRPS (RAW files and Photoshop) and Simon Walden (principal photographer at 
Cheltenham Film Studios - fashion and nude photography), who is well known for his workshops at the 
studios. Two professional models will be booked for the weekend. There will be instruction on the use of 
both Canon an9 Nikon DSLR cameras. PermaJet are supporting the event with printers and paper and you 
will be able to print your pictures. All three tutors will display examples of their work. There will also be room 
for members to display their pictures taken during the event. Bring your own laptop. e~\'c, 

Lunches available and a Travel Lodge and other hotels are nearby. ~\Ge~ 

\ o"'-1 o~ -~v.(l; ,.A~~ 
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